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Introduction 

The DriveRight Fleet Management Software (FMS) User’s Manual provides a comprehensive review of all DriveRight 
FMS functions. The information in this manual is also available by accessing the help file incorporated into the 
program.  We strongly recommend that you use this as a companion to the DriveRight FMS Getting Started Guide and 
the DriveRight FMS Database Selection Guide included with your software.   

•  The Getting Started Guide will walk you systematically through the initial steps of setting up your DriveRight 
system.   

•  The Database Selection Guide will help you choose and install the right database for your DriveRight FMS 
application.  

•  Once the system is established, this manual and the program help can serve as an ongoing reference. 

Welcome to DriveRight Fleet Management Software 

The DriveRight Fleet Management Software (FMS) allows you to store, view, and manipulate your driver safety and 
vehicle use data on a Windows-compatible computer. More specifically, FMS provides tools for sorting, tracking, 
analyzing and printing data, and viewing and printing reports from vehicle data for a large number of drivers and 
vehicles at multiple locations.  

DriveRight FMS features include: 

•  Tracking drivers, vehicles, locations, and service 

•  Viewing, graphing, printing and saving "accident log" information 

•  Multiple user levels  

•  Tamper logs 

•  Sorting data and creating reports according to user-defined selection criteria 

•  Summarize data by day and by trip 

•  Compare vehicles, drivers, or groups of drivers 

•  FTP Export / FTP Import data 

•  Palm download support 

What’s New for DriveRight FMS 3.1 

The most important change in DriveRight Fleet Management Software version 3.1 is support for the CarChip Fleet 
device. DriveRight FMS 3.1 also includes two new reports.  

CarChip Fleet Support 

•  Download CarChip Fleet data into the DriveRight FMS database. 

•  Store trip info, accident logs, and tamper logs. 

•  View and set CarChip Fleet configuration in both the device and FMS database. 

Note: DriveRight FMS 3.1 does not store engine data and diagnostic trouble logs in the database. This 
information can be downloaded and viewed using the CarChip software included on your DriveRight FMS 3.1 CD. 
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New Reports 

•  Time Over Speed Limit Exception Report 

•  Days Since Last Download Report 

Important Features in DriveRight FMS 

DriveRight FMS is a total redesign of the earlier versions of the DriveRight Vehicle Management Software (VMS). We 
designed and developed DriveRight FMS with an aim to provide: 

•  Robust database server support, able to handle large amounts data. 

•  Flexibility to configure and connect to more than one DataBase Management System (DBMS). 

•  Better Reports for both viewing and printing. 

•  Improved Database Browser. 

•  Better organization of data coming from different locations. 

•  Improved user interface. 

•  Flexible Database support for almost any relational database which supports SQL language, and has a 
OBDC driver. 

•  Supports the following relational database servers: MySQL, Microsoft SQL Server and Oracle. 

•  Free support for MS Access and MSDE, which are ideal for small fleets with a single user. 

•  A location field was added to the database tables to facilitate “rolling up” data which makes it possible to 
manage data from many locations in one database. 

•  FTP export and import data through the internet making it easier to move data from one location to another. 

•  Automatic backup and “zipping” of data  with the option of  keeping a fixed number of months in the database 
to help speed up operations. 

•  The “Add DriveRight” wizard makes adding a DriveRight to the program simpler and less prone to mistakes. 

•  Elimination of redundant reports and the addition of several new reports. 

•  Reorganized reports menu with several new and redesigned reports. 

•  Improved viewing and printing of reports. 

•  New “usage” report to help trace night and weekend driving. 

•  Improved exception reports for Excessive Speed, Hard Braking, and Night Driving. 

•  A “Relationship” report that shows a list of all DriveRights, which vehicles they are assigned to, along with a 
default driver if one has been assigned.  

•  Improved browser with user-configurable colors, fonts, and field widths. 

•  Simplified filter support to make it easier to select what you want. 

•  Use of standard calendar control for specifying dates. 

•  Email support for all Excel generated reports. 

•  Supports Palm PDA download of DriveRight consoles. 

Operational Differences Between Driveright FMS and Earlier Versions 

The operation of DriveRight FMS is very similar to DriveRight Vehicle Management Software (VMS) 2.x, but there are 
some fundamental changes that you should be aware of.    
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•  In 2.x the vehicle table contained all the information about a particular DriveRight, in addition to information on 
the vehicle.  However, in 3.0 a new table was introduced, the DriveRights table,  which stores DriveRight 
console information. Vehicle information is stored in the vehicle table, and DriveRight information is stored in 
the new DriveRights table.  In 3.0 , a DriveRight must be “assigned” to a vehicle.   When your old data is 
converted, for each vehicle in 2.x  a new DriveRight and vehicle is created in the 3.0 database.   

Note: A DriveRight is identified using it’s DriveRight ID, and a particular vehicle is identified using it’s Vehicle ID.   

Note: A “relationship” report was added to the program to help clarify the relationship between vehicles, 
DriveRights, and drivers.    

•  The “Set DriveRight” option in 2.06/2.6.1 appears as “View/Set” in the “DriveRight/DriveRight Settings” menu.  
Unlike 2.06/2.6.1, when changes are made to a DriveRight using this option, they are also stored in the 
DriveRight table.  

•  Adding a new DriveRight to the program can now be done more easily using the Add New DriveRight wizard 
which steps you through the process and helps clarify where you stand with respect to the calibration of the 
DriveRight. 

•  You will also notice that every table now has a “location” field.  The location field was added to facilitate 
“rolling up” of data from many locations so they can be managed in one database.   

Architecture 

DriveRight FMS architecture allows the software to be connected to any of the Database Servers we support. The 
communication between DriveRight FMS and Database is done through an OBDC connection by means of an OBDC 
driver. Currently DriveRight FMS supports MS Access, My SQL, MSDE, SQL Server and Oracle databases. Other 
databases may be added in the future. 

The following figure illustrates how DriveRight FMS connects to the back-end Database Server. 

 

Note: DriveRight FMS can only be connected to one database at a time. 
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When DriveRight FMS is opened for the first time, the user is prompted to select the database type to be used for this 
installation. Based on the user’s selection, a connection is established to one of the OBDC drivers. The database type 
is stored in the configuration file. 

Database Selection Guidelines 

DriveRight Fleet Management Software (FMS) supports the following databases. 

Single-User Databases: 

•  MS Access (Microsoft Access) (all required software included in DriveRight FMS) 

•  MSDE (Microsoft Desktop/Data Engine) (all required software included in DriveRight FMS) 

Multi-User Databases: 

•  MySQL (requires software license) 

•  MS SQL Server (Microsoft SQL Server) (requires software license) 

•  Oracle (requires software license) 

Note: Please refer to the DriveRight FMS Database Selection Guide for information on choosing and installing a 
database for your installation. 

Setup Overview 

The initial setup of your DriveRight FMS consists of the following operations: 

1. Database Selection and Installation 

You will be asked to select a database when you run the software for the very first time.  

2. Installing DriveRight FMS 

3. Initial Program Configuration when you first run DriveRight FMS. 

Refer to the DriveRight FMS Getting Started Guide for initial program configuration information. 

4. Converting DriveRight 2.04, 2.05 & 2.06 Databases 

If you have a DriveRight database created using version 2.04, 2.05, or 2.06 of the DriveRight Vehicle Management 
Software, it needs to be converted for use with DriveRight FMS 3.0.  

5. DriveRight FMS Software Setup 

Check the following configuration preferences and make any necessary changes: 

Set Units - Select your unit preferences for the data displayed in the dialog boxes, database browser, and reports. 

Automation Options - If this option is set, you will be prompted to backup data at the intervals specified, and also can 
set the amount of data to keep in the current database. 
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Download Options - Use this option to synchronize the DriveRight device date and time with your computer after 
each download. Also, if a downloaded device is either a 500 or 600 model, you can choose how the software will treat 
the Driver ID. Once set, this preference will be uniform for all devices. 

6. Set Default DriveRight Settings Wizard 

The values entered in this setup are used as default settings when you add new DriveRight devices to the database. 
You can set DriveRight default values using the Default DriveRight Settings Wizard in the Setup Menu. Check the 
default settings to make sure they suit your application. 

7. Set Default CarChip Settings 

The values entered in this setup are used as default settings when you add new CarChip devices to the database. You 
can set CarChip default values using the Default CarChip Settings command in the Setup Menu. Check the default 
settings to make sure they suit your application. 

Note: If you are using both DriveRight and CarChip devices in your fleet, be sure to set the Safety Settings 
uniformly for both types of devices.  

8. Select the Serial Port and Test Communications 
•  Use the Serial Port - DriveRight command in the Setup Menu to select the serial port used to connect to a 

DriveRight device.  

•  Use the Serial Port - CarChip command in the Setup Menu to select the serial port used to connect to a 
CarChip device.  

•  Use the Auto Detect feature in the Serial Port dialog box to test communications. 

9. CarChip Considerations 
•  If both a CarChip device and DriveRight console are installed in the same vehicle, you will need to create 

duplicate entries in the DriveRight FMS databases for the vehicle and driver. Otherwise you will see duplicate 
trip data in your DriveRight FMS reports. 

•  If you have multiple serial ports, you can connect CarChip to one serial port and DriveRight to another. If you 
do not have multiple serial ports we recommend you buy a serial switch box to switch between the two 
devices or a serial extension cord to make plugging and unplugging the download cables more convenient. 

•  If you are using both CarChip and DriveRight devices, make sure both types of devices use the same safety 
settings.  

•  Speed Band 3 in CarChip should match Speed Limit in DriveRight. 

•  Hard Braking in CarChip should match Decel Limit in DriveRight. 

•  Hard Acceleration in CarChip should match Accel Limit in DriveRight. 

•  Unlike DriveRight, a CarChip can be assigned either to a vehicle or to a driver. 

10. Building Your Database Tables – Adding DriveRights 

When you add a DriveRight you will need to assign a default vehicle. When you add a vehicle you will need to assign a 
default driver. So, it is most efficient to add the drivers first, the vehicles second and the DriveRights third. 

•  First, add all drivers. 

•  Second, add all vehicles. 

•  Third, add all DriveRights. 

Important: If you selected either a UNALLOCATED DRIVER or UNKNOWN VEHICLE, you should change 
them to real entries before actually using the DriveRight in the field and downloading it. 
Otherwise, the data will be assigned to the wrong entities and will affect the results when you 
run Reports, etc. 
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11. Building Your Database Tables – Adding CarChips 

When you add a CarChip you will need to assign it to either a vehicle or a driver. If you assign CarChip to a vehicle, all 
the downloaded data is assigned to the default driver of that vehicle. If you assign CarChip to a driver, all the 
downloaded data is assigned to that driver and the vehicle will be unallocated. 

•  If a CarChip will only be used in one vehicle, assign it to that vehicle. 

•  If a CarChip will be used by only one driver, assign it to that driver. A CarChip assigned to a driver can be 
used in multiple vehicles. 

12. Using the Software 

You are now ready to start using DriveRight FMS.  

Converting 2.04-2.06/2.6.1 Database to DriveRight FMS Format 

A separate conversion utility, OldToNew, has been included with the DriveRight FMS software to allow the conversion 
of existing DriveRight 2.04, 2.05, 2.06 and 2.6.1 database files for use with DriveRight FMS. 

Note: This conversion utility can only be used with databases created by DriveRight 2.04, 2.05, 2.06 or 2.6.1. If 
you are using an earlier version of the DriveRight software you must first upgrade to one of the supported 
versions. 

Use the following procedure to convert your existing DriveRight database for use with DriveRight FMS: 

1. Install and run DriveRight FMS before you convert your data to the new format.   

2. Verify the current location in DriveRight FMS using the Current Location command in the Setup Menu. This 
location information will be associated with all the 2.x data when converted into the new database format.  

 

3. To import data to a new location, select the Company Locations command in the Database Menu in DriveRight 
FMS, then click the Add New button in the Company Locations browse window.  

 

4. Go to Startup>Programs>DriveRight and run OldToNew. 

5. To import data, select the location from the drop down list. 
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6. Click the Browse button to select the old Borland tables directory (By default it is C:\Program Files\DriveRight 
Software\tables).  

7. Click the Convert button to start the conversion. Once the data is converted you will see a success message. 

Note: The conversion process can take a long time depending on the size of your 2.x database. You can interrupt 
the conversion at any time by clicking the stop button, but this is not recommended. 

8. Go to DriveRight FMS and view various tables using the Database Menu commands to make sure the data has 
been converted properly. 

Tool Bar Icon Information 

The tool bar icons provide quick access to frequently used coammands. Refer to the list below for each icon’s function. 

 

List of Toolbar Icons 

Database Icons 

View Trips Database 
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 View DriveRight Database 

 View CarChip Database 

 View Drivers Database 

 View Vehicles Database 

Add Device Icons 

 Add New DriveRight Wizard 

 Add New CarChip Wizard 

Report Icons 

 Driver Performance Score Report 

 Trip Summary Report 

 Usage Report 

 Odometer Report 

 Accident Log Report 

File Menu Command Icons 

 Print 

 Print Preview 

 Clear Screen 

Data Download/Export Icons 

 Download DriveRight 
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 Download CarChip 

 Download Palm 

 Export GPS Data to Mapping Software 

Help Icon 

 Help Topics 
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Menu Commands 

The main menu commands in DriveRight FMS provide access to program functions: 

•  File Menu – File-related commands such as backup, restore, import and export. 

•  Setup Menu – Program setup commands 

•  DriveRight Menu – DriveRight console commands for adding DriveRights, viewing or changing DriveRight 
settings, viewing accident and tamper logs. 

•  CarChip Menu – CarChip commands for adding CarChips and for viewing or changing CarChip settings. 

•  Database Menu – Database Table commands to view, add, edit or delete records 

•  Reports Menu – Create reports  

•  Help Menu – Access DriveRight FMS program help and view  program version info 
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File Menu 

The following commands are available in the File Menu: 

•  Backup 

•  Restore 

•  Import 

•  Export 

•  Print 

•  Print Preview 

•  Print Setup 

•  Clear Screen 

•  Exit 

Backup 

The Backup feature is used to archive old data as a zip file. The backup files are stored in the Backup sub-directory in 
the DriveRight FMS install directory. The Backup sub-directory is created the first time you back up your data.  

The backup zip files are named based on the start and end dates chosen for the backup. For example, if you pick the 
dates between March 6, 2003 and March 27, 2003, the backup file will be named 6March2003_27March2003.zip. 

You can configure how much data to keep active after a backup by setting up your Automation Option preferences in 
the Setup menu. Limiting the amount of data in the active database helps prevent the database from growing into an 
unmanageable size. 

Active Database Size Recommendations 

The following recommendations are based on tests and calculations made with these assumptions: 

•  10 trips per day per vehicle 
•  Trip duration: 1 hour (10 hours driving time per day per vehicle) 

•  GPS data logged every 10 seconds 

Note: If your fleet size exceeds the scenarios shown below, we recommend that you use a multi-user database. 
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Recommendations Table 
Scenario  Number of  

Vehicles  
Amount of Active Data 
in  
Database  

Remarks and Recommendations 

25  Up to 1 year  Backup data once a month for application performance. 
Using automation options you can set maximum of 1 year 
of data in the active database. 

50  Up to 9 months  
  

Backup data once a month for application performance. 
Using automation options you can set maximum of 9 
months of data in the active database 

Single-User 
Database with 
no GPS 

100  Up to 6 months  Backup data once a month for application performance. 
Using automation options you can set maximum of 6 
months of data in the active database. 

MSDE with 
GPS  

5  Up to 1 month  Backup data every month for application performance. 
Using automation options you can set maximum of 1 
months of data in the active database 

MS Access 
with GPS  
  

10  Up to 1 month  
  

Backup data every month for application performance. 
Using automation options you can set maximum of 1 
months of data in the active database. 
  

Multi-User 
Database 
with/without 
GPS 
  

Unlimited 3-6 months Backup data every month for application performance. 
Using automation options you can set maximum of 6 
months of data in the active database.  
  

  

Note: If you have GPS data, we recommend backing up more often than recommended, typically once a week.  
  

To backup data: 

1. Click Backup in the File menu. The Backup Files To dialog box is displayed. 
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2. From the Backup Files To dialog box select the folder where the backup file will be written. The Backup Options 
dialog box is displayed.  

Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight data. 

 

3. In the Backup Options dialog box check your last backup date and specify whether to backup the whole 
database or only those records falling within a specified time period. The start date will always be initialized to 
the last backup date. 

4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up your database. 

5. When the backup is finished, click OK to return to the program. 

Restore 

The Restore command is used to get a previously Backed up data back into the active database. In this process you 
can pick one or more tables to be restored. 

To restore data: 

1. Click Restore in the File menu. The Restore Files From dialog box is displayed. 
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2. From the Restored Files From dialog box select a single zip file to restore, and then click the Restore button. 
DriveRight FMS unzips the file and displays all the tables in the dialog, and displays the following dialog box: 

 

Note: You can only restore one zip file at a time. 

Note: The backup file filename is based on the start and end dates chosen for the backup. 

3. You can either restore all the database tables or restore individual database tables. Click Yes in the dialog box 
to restore all the tables. Click No to restore selected database tables. 

4. If you are restoring selected database tables, select each table to be restored. Hold down the Control key on 
your keyboard to select multiple tables. When you have finished making your selection, click Restore to restore 
the tables or click Cancel to exit without restoring the tables.  
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5. When the files have been restored, click OK to return to the program. 

Import Menu 

Use the Import Menu options to import DriveRight database data into DriveRight. 

•  Import: FTP Import 

•  Import: Other Data Commands 

Import: FTP Import 

FTP (File Transfer Protocol) Import allows you to import DriveRight data from a remote site. Use this procedure for 
FTP Import only. Use the Import: Other Import Commands procedure for all other import commands.  

Note: Before you start this operation, contact your systems administrator for your FTP account information. 

To use FTP Import: 

1. Select the Import command in the File Menu. 

2. Select FTP Import from the Import drop-down menu. The FTP Import dialog box is displayed. 
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3. In the FTP HostName edit box, type the name of the FTP server that you want to import the database tables 
from. eg: toolbox.davisnet.com 

4. In order to access the FTP site you must have a user account on the FTP site. Enter your user name and 
password in the edit boxes. 

5. In the Remote Path edit box, you can enter a specific directory path in the FTP server.  

6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a different port. 

7. Default connection to the FTP site is active mode. Some FTP sites allow only passive mode connections.(check 
the passive mode check box in that case). For details, contact your system administrator. 

8. Click the Import button. The following FTP Import dialog box appears, which displays the directories and files 
located at the specified location on the FTP server. 
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9. Locate and select the sub-directory named for the DriveRight FMS location from which you want to import the 
database tables. Click Import to open the directory. 

10. Locate and select the zip file containing the database tables you wish to import. Click Import to import the 
tables. 

11. When the files have been successfully imported, click OK to return to the program. 

Note: You can stop the import at anytime by clicking the Cancel button. 

Import: Other Import Commands 

Use the Import tables command to import individual DriveRight Tables into your database. This is the procedure for all 
import commands except FTP Import. 

To import data: 

1. Select Import in the File Menu. 

2. Select the table you wish to import (Drivers, Vehicles, Trips, etc.) from the list. 

3. When the Import dialog box appears, go to the directory where the file to be imported are located. Select the file 
to be imported and click Import to import the data or click Cancel to exit without importing. 

 

  

Export Menu 

Use the export menu options to export DriveRight FMS data. 

•  FTP Export - Use the FTP Export command to export database data to a remote site. 

•  Export GPS to Mapping Software - Use the Export GPS to Mapping Software command to export GPS data 
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in a format designed to be imported into mapping software. 

•  Export Accidents to Mapping Software - Use the Export Accidents to Mapping Software command to export 
accident GPS data in a format designed to be imported into mapping software. 

•  Other Export Commands - Use the other export commands to export the indicated type of data in a tab-
delimited text file. 

Export: Accidents to Mapping Software 

Note: This command can only be used for accidents logged by a DriveRight 600 equipped with the optional GPS 
module. 

To export accident log data: 

1. Select Accident to Mapping Software from the Export command in the File Menu. The Export Accidentlogs To 
dialog box is displayed. 

 

2. Select the file directory in which to save the accident log files. 

3. Verify the file name for the accident log file. You can edit the name in the dialog box if desired. 

4. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, the exported Accident 
Log data will be saved in a file ready to be imported into your mapping software. 

5. To export GPS data for selected drivers or DriveRights, click on Set Filter In the Export GPS To dialog box. The 
Filter for GPS dialog box appears. 
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6. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

7. To export data for all drivers and DriveRights, click the Browse All radio button. 

8. To export GPS records for a specific driver, click Driver Name and select the driver from the list. 

9. To export GPS records for a specific DriveRight, click DriveRight ID and select the DriveRight from the list. 

10. To export GPS records for a specific time interval, check GPS Between. Edit the Start Date & Time and the End 
Date & Time as desired. 

11. To export GPS records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

12. Click OK to set the filter or click Cancel to exit without changing the filter. The Export GPS To dialog box is 
displayed. 

13. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, the exported Accident 
Log data will be saved in a file ready to be imported into your mapping software. 

To import data into MapPoint: 

1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data pull down menu. 

3. Using the File Dialog find select the ACCIDENTLOGS.TXT file and click on Open. 

4. "Tab" should be selected to separate the data. Click Next. 

5. All the fields you exported will appear in the next dialog.  Column headings are included and should be detected 
by the program.  All the columns should have <Other Data> as their data type except Lat and Long.   Check to 
make sure the Lat and Long were detected correctly.  If they are not, correct them.  Click Finish. 

6. Choose Multiple Symbol and click Next. These instructions show you how to color code accident log points by 
speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select time_TO.  In "Divide the data you chose above by" list, 
select <None>. In "Show the data by" list, select Latitude & Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 
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9. Click Finish to plot the points. 

10. In the left frame, right click on "time_T0 by Latitude & Longitude". Select "Properties". Open the Balloon tab and 
select time_T0, accidentDateTime and any other fields you want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show Information", to look at data for 
that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes are ‘+’ to zoom in and 
‘-‘ to zoom out.  Also, you can draw a box around an area and then click in it to zoom into it.  You can scroll the 
map using your mouse by just positioning the mouse cursor on the side of the map you want to scroll into.   

Filter for GPS 

The Filter For GPS dialog box is displayed when you select the GPS command in the Database menu or when you 
select the Set Filter command when you are exporting data. The GPS filter allows you to select data based on the 
options you choose in the filter dialog box. 

  

To filter GPS data:  

  

1. Select the GPS command in the Database menu. The Filter For GPS dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check GPS Between and select a Start Date and End Date to select records for a specific time period. 

6. To select records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

7. Click OK to set the filter or click Cancel to exit the dialog box. 

  



 27 

Export: FTP Export 

FTP (File Transfer Protocol) Export shows all the available database tables that you want to export to the FTP site. By 
default all tables are selected. You can un-check the tables that you don’t  want to export. 

Note: Before you start this operation, contact your systems administrator for your FTP account information. 

Steps to follow: 

1. Select Export in the File Menu. 

2. Select the FTP Export from the menu list. The FTP Export dialog box is displayed. 

 

3. In the FTP Host Name box, type the name of the FTP server that you want to export the database tables.  

4. In order to access the FTP site you must have a user account on the FTP site. Enter your user name and 
password in the appropriate boxes. 

5. In the Remote Path box, you can enter a specific directory path in the FTP server to which to export your files.  

6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a different port. 

7. Default connection to the FTP site is active mode. Some FTP sites allow only passive mode connections.(check 
the passive mode check box in that case). For details, contact your system administrator. 

8. Select the database tables to be exported by clicking the box for each table. Click a second time to de-select the 
table. 
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9. If desired, you can export records that are dated within a specified time interval. The default start date for the 
interval is the last date of export. The default end date is the current date. You can change the start and end 
dates as required. If you have exported data previously, the last date of export is displayed in the dialog box. 

10. Click export button once you are done with the above steps.  

11. Application will create a sub-directory with your current location name on the FTP site, if it doesn’t already exist, 
and then exports a ZIP file to the sub-directory. Default name for the export ZIP file is "day" + "month" + 
"year".zip (20jan2003.zip). 

Export: GPS to Mapping Software 

DriveRight can export GPS data to be used for plotting by third party software. 

To export GPS data: 

1. Select Export in the File Menu. 

2. Select GPS to Mapping Software in the drop-down Export menu. The GPS Fields dialog box is displayed. 

 

3. Only the checked GPS fields will be exported. Click on Select All to check all fields. Click on Clear all to clear all 
fields. Click in the box for each field to toggle the check on and off.  

4. Note: These key fields should always be selected: GPS DateTime, Speed, High Speed, Latitude and Longitude. 

5. Click OK in the GPS fields box to continue, click cancel to exit. If you click OK, the Export GPS To dialog box is 
displayed. 
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6. The default file name is GPS.TXT and the default directory is the DriveRight FMS install directory. You can edit 
or change the file name directly in the text box. You can also change the directory in which the exported GPS 
data file will be saved.   

7. Click the "Set Filter" button to narrow the selection of GPS data to be exported.   

8. Click the Browse button to view the GPS data before you export it. 

9. Press OK when you are ready to export the GPS data or click Cancel to exit without exporting data. If you click 
OK, the exported GPS data will be saved in a file ready to be imported into your mapping software. 

To import GPS data into MapPoint: 

1. Start the MapPoint application. 

2. Select Import Data Wizard from the Data pull down menu. 

3. Using the File Dialog find select the GPS.TXT file and click on Open. 

4. "Tab" should be selected to separate the data. Click Next. 

5. All the fields you exported will appear in the next dialog.  Column headings are included and should be detected 
by the program.  All the columns should have <Other Data> as their data type except Lat and Long.   Check to 
make sure the Lat and Long were detected correctly.  If they are not, correct them.  Click Finish. 

6. Choose Multiple Symbol and click Next. These instructions show you how to color code accident log points by 
speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select highSpeed.  In "Divide the data you chose above by" list, 
select <None>. In "Show the data by" list, select Latitude & Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 

9. Click Finish to plot the points. 

10. In the left frame, right click on "highSpeed by Latitude & Longitude". Select "Properties". Open the Balloon tab 
and select gpsDateTime, highSpeed and any other fields you want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show Information", to look at data for 
that particular point. 
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12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes are ‘+’ to zoom in and 
‘-‘ to zoom out.  Also, you can draw a box around an area and then click in it to zoom into it.  You can scroll the 
map using your mouse by just positioning the mouse cursor on the side of the map you want to scroll into.   

Export: Other Export Commands 

Use the Export "data type" command to export the data in the database to a file. The exported files are in a tab-
delimited text file format and can be used to exchange information within your company, with your clients, etc. 

To export data: 

1. Select Export in the File Menu. 

2. Select the data type you wish to export (Drivers, Vehicles, Trips, Costs, etc.) from the drop-down menu. The 
Export "data type" To window is displayed. The Export Trips To window is shown here as an example. 

 

3. Create a name for the file you wish to export on the Export File Name box (for example: Trips.txt). 

4. Use the browse function in the Export data type To dialog box to select a destination where you wish to place 
the file. 

5. In some cases, you can use the Set Filter option to more specifically specify the data to be exported (for 
example: export only information related to one driver, or a group, or a period of time, etc.). 

6. If you wish you can view the file before exporting by clicking the Browse button. This will give you the 
opportunity to view the selected records that will be exported. 

7. If the data is correct, you can click the Export button to create the export data file.  

  

Print 

Use the Print command to print a DriveRight report that is displayed on your screen. 
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To print: 

1. Click Print in the File menu. The print dialog box appears. 

2. Select your desired print options. 

3. Click OK to print or click Cancel to exit the dialog box without printing. 

Note: The Print command is only enabled when a report is being displayed. 

Print Preview 

To preview a print job: 

1. On the File menu, click Print Preview.  

2. Use the buttons on the toolbar to look over the page or make adjustments before printing.  

Print Setup 

To setup your print options:  

1. On the File menu, click Print Setup.  

2. Select your desired print options. 

3. Click OK to save the settings or click Cancel to exit the dialog box without saving. 

Clear Screen 

Use the Clear Screen command to clear reports from the main program window. 

To clear the screen: 

1. Click Clear Screen in the File menu. The main program window is cleared. 

2. You can also use the Clear Screen icon to clear the screen:  

Exit 

Use the Exit command to close the DriveRight software. 

To exit the software: 

1. Click Exit in the File menu. The software quits. 
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Setup Menu 

The following commands are available in the Setup Menu: 

•  Current Location 

•  Users 

•  Preferences 

•  Host Mode 

•  Serial Port – DriveRight 

•  Serial Port - CarChip 

•  Default DriveRight Settings 

•  Default CarChip Settings 

•  Digital Input Labels 

Current Location 

DriveRight FMS allows you to organize your data according to location.  All information is stored as part of the Current 
Location. You need to set Current Location value properly for proper data storage. Once current location name is set, 
the corresponding location id is stored in all the downloads. All operations like database browsing, reporting, etc, are 
performed with respect to the current location.  

To change the current location: 

1. Choose the Current Location command in the Setup Menu. The Set Current Location dialog box is displayed: 

 

2. Select the desired location from the drop-down list. 

3. Click Set to change the location or click Cancel to exit without changing the current location. 

  

Note: A new location can be added by going to Database->Company Locations, and clicking Add New button in 
the Browser. 

Users Command Menu 

The Users Menu commands allow you to log in and to change your password. If you are the Super User you can also 
browse the list of registered users. 

•  Login 



 33 

•  Browse/Add Users 

•  Change Password 

Users: Login 

The Users Login command allows you to change the User without exiting the program. You must be a registered user 
to access program functions. 

To change the current user: 

1. Select Login from the Users command in the Setup Menu. The Login dialog box is displayed. 

 

2. Enter your User Name and Password. 

3. Click OK to log in, or click Cancel to exit the dialog box without changing the current user. 

Users: Browse/Add 

The Users Browse/Add command opens the Users browse window showing you a list of all registered users, including 
their passwords. From this window you can add new users or edit the privileges of existing users. 

Note: You must be logged in as the Super User to access this command. 

To open the Users browse window: 

1. Select Browse/Add from the Users command in the Setup Menu. The Users browse window is displayed. 

2. Click on Add New to add a new user. 

3. To change a user’s settings, click on the user in the browse window and then click on Edit. 

4. To delete a user, click on the user in the browse window and then click on Delete. 

5. To print the browse window, click on Print. 

6. Click Close to exit the window, or click on the close icon in the upper right corner of the window. 

Users: Add New 

When your add a new user to DriveRight FMS, you assign the user name, password, and access privileges. 

To add a new user: 

1. Select Browse/Add Users from the Users command in the Setup Menu. The Users browse window is displayed. 



 34 

2. Click the Add New button located in the lower left corner of the window. The Add User Privileges dialog box is 
displayed. 

 

3. Enter the User Name and Password. 

4. Configure the desired access privileges for the new user. 

•  The DriveRight Access options allow you to limit a user’s access to DriveRight and CarChip devices. 

•  The Application Options allow you to limit a user’s access to individual program functions. 

•  The Database Table Access options allow you to limit a user’s access to the DriveRight database. 

5. Use the All Rights button to grant all privileges to the new user. You can then selectively remove unwanted 
privileges from the new user before adding the user to the database. 

6. Use the Clear Rights button to remove all privileges from the new user. You can then selectively add desired 
privileges to the user before adding the user to the database. 

7. Click Add to add the new user or click Cancel to exit without adding the user. 

Users: Edit 

Use the Edit command to change user information. User information includes the user name, password and the user’s 
access privileges to functions and data in the software. 

To edit user information: 

1. Select Browse/Add Users from the Users command in the Setup Menu. The Users browse window is displayed. 

2. Click the Edit button located in the lower left corner of the window. The Edit User Info dialog box is displayed. 
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3. You can change the user name, password and privileges as desired. 

•  The DriveRight Access options allow you to limit a user’s access to DriveRight and CarChip devices. 

•  The Application Options allow you to limit a user’s access to individual program functions. 

•  The Database Table Access options allow you to limit a user’s access to the DriveRight database. 

4. Use the All Rights button to grant all privileges to the user. You can then selectively remove unwanted privileges 
from the new user before saving the user information. 

5. Use the Clear Rights button to remove all privileges from the user. You can then selectively add desired 
privileges to the user before saving the user information. 

6. Click OK to change the user’s info or click Cancel to exit the dialog box without changing the user information. 
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Users: Change Password 

The Change Password command in the Users command menu allows you to change your DriveRight FMS password.  

To change your password: 

1. Select Change Password from the Users command menu in the Setup Menu. The New Password dialog box is 
displayed. 

 

2. Enter your new password, then retype your new password.  

3. If the retyped password doesn’t match, you will be prompted to check the retyped password.  

Note: In order to change your password the new password and the retyped new password must match exactly. 

4. Click OK to change your password or click Cancel to exit the dialog box without changing your password. 

Preferences Menu 

You can set the following program preferences in DriveRight FMS: 

•  Units 

•  Automation Options 

•  Download Options 

•  Database Browser 

Preferences: Units 

The Units dialog box allows you to select the units used for distance and speed and also control the display of the time 
and date. 

To set units: 

1. Choose Units from the Preferences command in the Setup menu.  

The Units dialog box appears. 
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2. Select the desired distance/speed, date, and time options. 

3. Choose OK when you are satisfied with the settings, choose Cancel to exit without changing the settings. 

Preferences: Automation Options 

Use the Automation Options command to set the time interval at which DriveRight FMS will prompt you to backup your 
database and to set the number of months of records to keep in the active database. Refer to the Active Database 
Size Recommendations topics located in the File Menu>Backup Command section of this manual and in the 
DriveRight FMS help for more information 

To set your download options: 

1. Choose Automation Options from the Preferences command in the Setup menu.  

The Automation Options dialog box appears. 

 

2. Check the box for "Prompt for backing up database once every X months " then select the number of months 
from the drop down list to have DriveRight FMS prompt you when the next backup is due. 

3. Check the box for "Keep X months of records active in the database after every backup" then select the number 
of months from the drop down list to keep the selected number of months active in the database after a backup. 
All data recorded before the specified period of time will be removed from the active database.  
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Preferences: Download Options 

Use the Download Options command to set up the automatic synchronization of the DriveRight’s clock after each 
download and to determine how the software will handle the Driver ID code in the Trip 500AL and DriveRight 600 
console data. 

To set your download options: 

1. Choose Download Options from the Preferences command in the Setup menu.  

The Download Options dialog box appears. 

 

2. Select "Synchronize time and date after every download" to have your DriveRight unit’s clock automatically 
reset to match your computer after each download. 

Note: If you choose this option, all DriveRight consoles included remote units downloaded through host mode will 
be reset to the computer’s time and date, even if the remote DriveRight is in a different time zone. 

3. If you are using DriveRight Trip 500AL or DriveRight 600 consoles, set the DriverID as either the Location ID or 
the Driver ID. 

4. Click OK to save the changes, click Cancel to exit without saving. 

Preferences: Database Browser 

Use the Database Browser commands to change the text font and color and the background color used in the Browser 
windows. 

•  Text Font and Color 

•  Background Color 

Text Font and Color 

Use this command to change the font and color used to display data in browse windows. 

  

To edit the text font and color: 

1. Choose Text Font and Color from the Database Browser command in the Preferences command in the 
Setup menu.  

The Font dialog box appears. 
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2. Select the desired settings for the font. 

3. Choose OK when you are satisfied with the settings, choose Cancel to exit without changing the settings. 

Background Color 

Use the Background Color command to change the background color for the database browser windows.  

 To edit the browser window background color: 

1. Choose Background Color from the Database Browser command in the Preferences command in the Setup 
menu. The Color dialog box appears. 
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2. Select the desired background color settings. 

3. Choose OK when you are satisfied with the settings, choose Cancel to exit without changing the settings. 

Host Mode Menu 

Host Mode allows drivers to dial in remotely and download their DriveRight using a modem. 

•   Host Mode On 

•  Host Mode Setup 

•  Remote Modem Setup 

Host Mode On 

This is the mode that your modem should be in when someone wants to call in from outside to transfer data from one 
or more DriveRight devices. A dialog box appears indicating that the modem is being initialized. After the initialization 
has been completed successfully, the other party can call in. When the Host Mode is on, all other software operation 
are suspended. 

Tip: It’s a good idea to set a schedule for remote drivers to call into the Host computer. For example, setting the 
rules to call outside business hours, then leaving the computer in Host Mode as the last task of the day will give 
drivers flexibility to call in. Alternatively, one computer can be dedicated as the Host, and data can be exported 
from it periodically to another computer where analysis and reporting are performed. 

•  The user connects his modem to the DriveRight (showing the CURRENT screen) using the remote download 
Kit (item #8188, purchased separately).  

•  The host mode is a well-protected function. You can only communicate as long as a DriveRight is connected 
to your PC. In all other cases, communication is lost. 

•  For details on how to install a remote modem to enable it to participate in the Host Mode, please consult the 
instructions accompanying the Remote Download Kit. 

•  The History Window displays status information for downloaded DriveRights.   

•  Hang Up:  Generally, you will not need this button because the software will hang up automatically. However, 
if necessary you can manually hang up the phone using this button. 

•  Reinitialize Modem: Resets the modem initialization. 

•  Exit Host Mode:  Exit host mode and resume normal program operation. 

Host Mode Setup 

Host Mode Setup allows you to configure your computer’s modem to accept calls. 

To be able to communicate with the DriveRight and transfer data over a modem, the communications port should be 
defined for your modem. Furthermore, set the modem of your PC to Auto-Answer when there is a call. Refer to your 
modem manual for Auto-Answer. 

•  Select the COM Port that your modem is connected too.   

•  The default initialization strings are "AT E1 Q0 &B1 &N0 V1" and "ATS0=3" for string 1 and string 2.   

•  Click Detect Modem to detect the serial port to which the modem is connected. 

•  If you are going to download just DriveRight 500 AL and earlier models just check that box.  See description 
below for explanation as to why this is necessary. 
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Note: Because the DriveRight 500 and earlier versions of DriveRight communicate at 2400 baud and the 
DriveRight 600 communicates at 19,200 baud, you must configure your computer to communicate with either the 
DriveRight 600 or with earlier models.  

Remote Modem Setup - Using Hyper Terminal 

The external modem at the site where the DriveRight is connected is called the "remote" modem. The DriveRight 
owner, when he wants to download his information, connects the DriveRight to this modem using the interface box and 
modem adapter included in the Remote Modem Kit. He then turns the modem on, and it will dial the host computer and 
the download will be initiated. However, before the modem will dial up the host computer and download correctly it 
must be set up correctly. The following instructions explain how to do this manually for a US Robotics Courier V. 
Everything modem and the Windows 95 accessory program Hyper Terminal. In addition, the setups for US Robotics 
56K Fax Ext are included.   

Unfortunately, not all modems have the same command set or act the same way on power up. If you are using a 
modem other than the one described, read the instructions below and then refer to your specific modem 
documentation to determine if your modem can be used. 

Note: When you are asked to type a command, do not type the quotes.  Type all commands in upper case. 

1. Take the modem out of the box and check that the DIP switches are set in the following way: 

Switch Number:  1  2  3  4  5  6  7  8  9 10 
Switch Setting:   0  0  0  1  1  0  0  1  0  0 

Note: 0 is short for OFF and 1 is short for ON.  These DIP switches only apply to the US Robotics Courier V. 
Everything modem. 

2. Using the Remote Modem Kit, connect the remote modem to a known serial port, and then turn the modem on. 
Make sure you use the gray phone cable included in the kit to go from your serial port to the modem. The black 
phone cable included in the DriveRight Software kit will not work for a modem. 

3. Run the Hyper Terminal  program. You can find the program in the Start menu under 
Programs/Accessories/Hyper Terminal. Click on one of the phones in the program group to start the program. 

4. Select "Properties" from he File menu and make sure you have the correct serial port selected. If you are not 
sure, you will have to use trial and error. In most cases "Direct to COM1" or "Direct to COM2" should work.  The 
File/Save As command can be used to save these settings under a name of your choice. You then can click on 
the phone with this name to start Hyper Terminal next time. 
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5. Type the letters "AT" and press enter. If you get an OK back, you are communicating with the modem.  If you do 
not, type the following commands. 

"ATE1V1Q" and press Enter 

You should now be able to type "AT" and press enter and receive an OK back.  You should also be able to see 
the "A" and the "T" when you type them. 

If the above test fails, check your connections and then try another COM port by changing your selection in the 
Properties option in the File menu. 

6. Enter the following commands to program the modem.  You should receive an "OK" after each one of the 
commands below unless stated otherwise. 

"ATS13=16" and press Enter 

Now, you will program the phone number to be dialed.  In the example below, the host computer is connected to 
780-6455. 

"AT&Z0=780-6455" and press Enter 

Now the modem will dial this number when it is turned on. 

"AT&W" and press Enter 

This setup is now saved in non-volatile memory which is loaded when the modem is turned on. 

"AT&M4" and press Enter 

This tells the modem to use a standard error detection protocol which should be used to insure the data transfer 
is done error free. 

"ATE0Q1" and press Enter 

You will not receive an "OK" after this command.  "Q1" tells the modem to operate in "quiet" mode. This is 
necessary so the DriveRight does not interpret any responses from the modem as commands. Note also, 
command will no longer be echoed. If you type AT Enter, you will see nothing; however, this is what we want 
and why we waited to do this on the last step. 

7. Exit Hyper Terminal: You are now ready to test your programming. If you have two separate phone lines and the 
DriveRight software you can completely test your setup. Plug in a working phone line to the remote modem and 
the "correct" phone line into your computers internal or external modem. The "correct" line is the one belonging 
to the number you programmed in step 5. Run the DriveRight software and put it in "host" mode by selecting 
"Host Mode On"  in the Setup/Host Mode menu. Connect the DriveRight to be downloaded to the external 
modem through the interface box and the black cable, not the gray cable you used to program the modem. Turn 
the modem off and then back on again. The modem should dial the host, the computer should answer the call 
and download the data. The DriveRight owner knows the download is completed when the CD light goes off. 
Under any circumstances, the download should be completed in no more than 5 minutes. 

Modem Configurations For Testing 

Below are the modem configurations for the US Robotics modems used during testing. 

FIELD MODEM: 

•  For DriveRight 500 make sure &N3 (if DriveRight 600 not selected in Host Mode Setup &N0 will also work.) 

•  For DriveRight 600 make sure &N0 or &N10. 

USRobotics Courier V.Everything Settings... 

   B0  C1  E0  F1  M1  Q1  V1  X1 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE   ON HOOK   TIMER 

   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1  &L0  &M4  &N3 

   &P0  &R1  &S0  &T5  &U0  &X0  &Y1  %N6  #CID=0 

   S00=000  S01=000  S02=043  S03=013  S04=010  S05=008  S06=002  S07=060 

   S08=002  S09=006  S10=014  S11=070  S12=050  S13=016  S14=001  S15=000 

   S16=000  S17=000  S18=000  S19=000  S20=000  S21=010  S22=017  S23=019 

   S24=150  S25=005  S26=001  S27=000  S28=008  S29=020  S30=000  S31=000 
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   S32=009  S33=000  S34=000  S35=000  S36=000  S37=000  S38=000  S39=000 

   S40=000  S41=000  S42=126  S43=200  S44=015  S45=000  S46=000  S47=000 

   S48=000  S49=000  S50=000  S51=000  S52=000  S53=000  S54=064  S55=000 

   S56=000  S57=000  S58=000  S59=000  S60=000  S61=000  S62=000  S63=000 

   S64=000  S65=000  S66=000  S67=000  S68=000  S69=000  S70=000 

   LAST DIALED #: T293-3529 

Switch 4,5, and 8 ON all others off. 

FIELD MODEM: 

•  For DriveRight 500 make sure &N3. 

•  For DriveRight 600 make sure &N0 or &N10. 

U.S. Robotics 56K FAX EXT Settings... 

   B0  E0  F1  M1  Q1  V1  X1  Y0 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE    ON HOOK   CID=0 

   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1 

   &M4  &N10  &P0  &R1  &S0  &T5  &U0  &Y1 

   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 

   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=016 

   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 

   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 

   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 

   S41=000  S42=000 

   LAST DIALED #: T2933529 

SWITCH 4,8 ON all others OFF. 

HOST MODEM: 

U.S. Robotics 56K FAX EXT Settings... 

   B0  E1  F1  M1  Q0  V1  X1  Y0 

   BAUD=19200  PARITY=N  WORDLEN=8 

   DIAL=TONE    ON HOOK   CID=0 

   &A1  &B1  &C1  &D2  &G0  &H0  &I0  &K1 

   &M4  &N0  &P0  &R1  &S0  &T5  &U0  &Y1 

   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 

   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=000 

   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 

   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 

   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 

   S41=000  S42=000 

   LAST DIALED #: 

SWITCH 3,8 ON all others OFF. 

DriveRight Software Host Mode Setup 

Inititialization String 1: AT E1 Q0 &B1 &N0 V1 

Inititialization String 2: ATS0=3 
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Serial Port – DriveRight Settings 

Use the Serial Port - DriveRight Settings command to select the serial port used to connect a DriveRight device to your 
computer. 

To select a serial port for a DriveRight device: 

1.  Choose the Serial Port - DriveRight Settings command in the Setup Menu. The Serial Port Settings dialog box 
is displayed: 

 

2. Select the serial port from the list provided. DriveRight FMS supports COM1 through COM8. 

3. If you are not sure which serial port you are using, connect your DriveRight to your computer: 

•   Press the Mode button on the DriveRight if necessary to make sure it is on. 

•  Click the Auto Detect button.  

•  If the DriveRight is found by the software, the following message is displayed and the correct serial port is 
selected in the dialog box. 

 

4.  Click OK to save the serial port selection or click Cancel to exit the dialog box without changing the serial port. 

Note: If you are working on a network, ask the network administrator to assist you in selecting the correct serial 
port.  

Serial Port – CarChip Settings 

Use the Serial Port - CarChip Settings command to select the serial port used to connect a CarChip device to your 
computer. 

To select a serial port for a CarChip device: 

1.  Choose the Serial Port – CarChip Settings command in the Setup Menu. The Serial Port Settings dialog box is 
displayed: 
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2. Select the serial port from the list provided. DriveRight FMS supports COM1 through COM8. 

3. If you are not sure which serial port you are using, connect your CarChip to your computer: 

•  Click the Auto Detect button.  

•  If the CarChip is found by the software, the following message is displayed and the correct serial port is 
selected in the dialog box. 

 

4.  Click OK to save the serial port selection or click Cancel to exit the dialog box without changing the serial port. 

Note: If you are working on a network, ask the network administrator to assist you in selecting the correct serial 
port.  
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Default DriveRight Settings Menu 

Use the Default DriveRight Settings> View/Set command to review or edit the default settings used by all new 
DriveRights added to the system. The Default DriveRight Settings Wizard simplifies the task of creating default 
DriveRight settings. 

•  View/Set 

•  Setup Wizard 

Default DriveRight Settings View/Set 

Use the Default DriveRight Settings View/Set command to view or edit the DriveRight FMS default DriveRight console 
settings..  

To view or edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  

2. Select View/Set from the list of commands. The Default DriveRight Settings dialog box is displayed. 

 

3. Select a tab to view or edit the following default settings: 

•  Unit Settings: Select the date, time and unit modes and click OK. 

•  Safety Settings: Enter the speed, acceleration and deceleration limits and click OK. 

•  Timer Settings:Enter the trip stop time and driver log out time and click OK. 

•  Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

•  Security Settings: Enter the security code (PIN code). Tamper indicator is an option.  

4. When your are finished, click OK to save any changes or click Cancel to exit without saving changes. 
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Default DriveRight Settings Wizard 

The values entered in this setup are used as default settings when you add new DriveRight devices to the database. If 
you click this menu option , a dialog box pops up that contains a brief description about the Default DriveRight Settings 
Wizard.  

To edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  

2. Select Setup Wizard from the list of commands. The Default DriveRight Wizard dialog box is displayed. 

 

3. If you choose OK, the Default DriveRight Settings Wizard takes you through the dialog boxes listed in the 
following steps. 
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4. Unit Settings: Select the date, time and unit modes and click OK. 

•  Date Mode settings control the way month, day, and year are displayed. 

•  Time Mode settings control the time of day display. 

•  Distance Unit settings allows you to select miles and miles per hour or kilometers and kilometers per hour 
as your speed and distance units. 
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5. Safety Settings: Enter the speed, acceleration and deceleration limits and click OK. 

•  Set the Speed Limit, which is the maximum allowable vehicle speed. 

•  Set the Accel Limit, which is the maximum allowable rate of acceleration. 

•  Set the Decel Limit, which is the maximum allowable rate of deceleration. 
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6. Timer Settings: Enter the trip stop time and driver log out time and click OK. 

•  Set the trip stop time in minutes. The trip stop time is the number of minutes that elapse after a vehicle 
stops before the DriveRight stops recording trip data. 

•  Set the Driver ID Logout Time in minutes. Use a logout time of "0" to never log out the driver. The Driver ID 
Logout Time is the number of minutes that elapse after a vehicle stops before the driver is logged out of the 
DriveRight. 
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7. Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

•  Set the Alarm Mode to On or Off. This controls audible alarm reporting by the DriveRight device. 

•  Enable "Warn if not Logged in" to have the DriveRight device give an audible alarm if the vehicle is 
operated without the driver first entering his or her driver code. 
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8. Security Settings: Enter the security code (PIN code). Tamper indicator is an option.  

•  Set the Security PIN Code, which is required to change the calibration and alarm settings at the DriveRight 
device itself. 

•  If desired, you can enable the tamper indicator. If enabled, the tamper indicator on the DriveRight LCD 
screen will be displayed when a tamper event has been detected.  
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9. Once you are finished with the above five dialog boxes, a tab control dialog box appears with all the above five 
dialog boxes. You can navigate through them, change any of the settings, and save the settings by clicking OK. 
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Default CarChip Settings 

Use the Default CarChip Settings command to view or edit the DriveRight FMS defaults for CarChip. 

 To view or edit the Default CarChip Settings:  

1. Select Default CarChip Settings in the Setup Menu. The Default CarChip Settings dialog box is displayed. 

 

2. You can edit the settings for Hard Braking, Acceleration, Speed Bands, and Engine Parameters. 

•  The CarChip settings for Hard Braking Threshold, Hard Acceleration Threshold, and Speed Band 3 are 
equivalent to the DriveRight settings for Decel Limit, Accel Limit, and Speed Limit. 

•  Set the Hard Braking Threshold to equal the Decel Limit used by DriveRight Devices. 

•  Set the Hard Acceleration Threshold to equal the Accel Limit used by DriveRight Devices. 

•  Set Speed Band 3 to equal the Speed Limit used by DriveRight Devices. 

3. When your are finished, click OK to save any changes or click Cancel to exit without saving changes. 
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Digital Input labels 

You can add labels to identify the two digital inputs signals available on a DriveRight 600 using this command. These 
labels appear on the browse windows and on reports. 

To change the digital input labels: 

1. Click Digital Input Labels in the Setup menu. The Digital Input Labels dialog box is displayed. 

 

2. Edit the labels used for digital input 1 and digital input 2. 

3. Click OK to save the changes or click Cancel to exit without saving the changes. 
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DriveRight Menu 

Use DriveRight Menu commands for functions that require direct communications with the DriveRight console.  

Note: The DriveRight must be connected to your computer with the LCD display on and in the CURRENT mode in 
order to access the DriveRight Menu commands. 

The following DriveRight Menu commands are available: 

•  Add New DriveRight 

•  DriveRight Settings 

•  Download DriveRight 

•  Download Palm 

•  Read Accident Log 

•  Read Tamper Log 

•  Set Time and Date 

•  Set Odometer 

•  Set Service Alarms 

•  Set Drivers List 

•  Clear DriveRight 

Add New DriveRight Wizard 

DriveRight FMS includes an Add New DriveRight Wizard to simplify adding DriveRight devices, Vehicles, and Drivers 
to the database.  

To add a new DriveRight device: 

1. Select Add New DriveRight from the DriveRight Menu. The Add DriveRight Wizard - Start dialog box is 
displayed. 

Note: The new DriveRight device must be connected to your computer and be turned on before you can add it to 
the DriveRight FMS database.  
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2. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 

If you click Next, the Add DriveRight Wizard - DriveRight ID dialog box is displayed. 

 

3. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 

If you click Next, the Add DriveRight - Assign to Vehicle dialog box is displayed. 

 

4. Click OK to continue, or click Cancel to exit the Add DriveRight Wizard. 

5. If you click Ok, the Add DriveRight Settings dialog box is displayed. The Add DriveRight Settings Dialog allows 
you to review all of the settings for the new DriveRight, including those settings that are set by the DriveRight 
defaults.  
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6. When you are satisfied it is set up correctly, select Set to save the settings. Select Cancel to exit the setup 
dialog and abandon the DriveRight settings. 

Note: If you cancel the setup, you will lose the DriveRight settings but any vehicles or drivers you added to the 
database will remain. 

Add DriveRight Wizard - Start 

Make sure the new DriveRight device is connected to your computer and turned on before proceeding.  

1. To skip this message in the future, check the "Don’t show this dialog again" box.  

2. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 
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Add DriveRight Wizard - Assign to Vehicle 

You must assign the DriveRight when you are adding it to the database. 

Assign DriveRight to Vehicle Guidelines: 

•  Both the default vehicle and driver must be in the database before you can successfully add a DriveRight. 

•  If no vehicles have been added to the database yet, you will be allowed to add a vehicle in the next dialog 
box.  

•  If there are no drivers in the database, you will also be allowed to add a driver when adding the vehicle.  

•  If the vehicle for this DriveRight already exists in the database, highlight the vehicle in the browse window and 
click Select. 

 

To Assign DriveRight to Vehicle: 

1. Press OK to assign the DriveRight to a vehicle or press Cancel to exit the Add DriveRight Wizard. 

2. If you press OK, the Vehicles browse window is displayed, which shows all the vehicles in the database.  

3. Click on the vehicle you want to assign to the new DriveRight.  

4. Click on the Select button in the bottom of the window to assign the vehicle or click Cancel to exit the Add 
DriveRight Wizard. 

5. The following dialog box is displayed:  

 

6. Click on Yes to continue installing the DriveRight with the selected vehicle or click on No to select a different 
vehicle. 
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Add DriveRight Wizard - DriveRight ID 

A DriveRight ID must be assigned to the new DriveRight device. 

  

1. The DriveRight ID dialog box shows the ID assigned to the DriveRight.  

•  You can change the assigned ID by clicking inside the text box and editing the number. 

•  Click on Browse DriveRights to view DriveRight ID’s in use at the current location. 

•  Click next to begin adding a new DriveRight to the database. 

 

2. If no vehicles have been added to the database yet, you will be allowed to add a vehicle in the next dialog box.  

•  If there are no drivers in the database, you will also be allowed to add a driver when adding the vehicle.  

•  Both the default vehicle and driver must be in the database before you can successfully add a DriveRight. 

•  If the vehicle for this DriveRight already exists in the database, you will only need to select it from the Vehicle 
Browse window. 

DriveRight Settings 

The following commands allow you to view and or change the settings on a DriveRight device: 

  

•  View/Set 

•  Restore 

•  Setup GPS 

•  Verify DriveRight Calibration 

DriveRight Settings: View/Set 

Use this command to view and/or modify the DriveRight device settings: 

1. Select DriveRight Settings from the DriveRight Menu. 
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2. Select View/Set from the DriveRight Settings drop down list. The DriveRight Device Settings dialog box is 
displayed. 

 

3. Make any desired changes. 

4. Click Set to save the changes or click Close to exit without saving. 
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DriveRight Settings: Restore 

Use this command to update the DriveRight device using settings stored in the database: 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select Restore from the DriveRight Settings drop down list. The Restore DriveRight Settings dialog box is 
displayed. 

Note: If the DriveRight has already been configured the software will automatically display the existing settings.  

 

3. Select the desired DriveRight ID and driver name from the drop down lists.  

Note: The software will only display DriveRight ID’s for DriveRight’s of the same type. If a DriveRight 600 is 
connected to your computer, you will only see ID numbers for other DriveRight 600 devices. 

4. Click Restore to save the selected settings to the DriveRight unit, or click Cancel to exit without changing the 
settings. 

DriveRight Settings: Setup GPS 

Use this command to view and/or modify the GPS settings on a DriveRight device. 

Note: This command only works with the DriveRight 600. 

To setup GPS logging: 

1. Select DriveRight Settings from the DriveRight Menu. 

2. Select Setup GPS from the DriveRight Settings drop down list. The Setup GPS Logging Interval dialog box is 
displayed. 
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3. Set GPS Logging to On, Off, or DriveRight Speed Only. 

•  Select On to enable GPS logging. 

•  Select Off to disable GPS logging. 

•  Select DriveRight Speed Only to log the DriveRight speed without the GPS coordinates. No GPS unit is 
required to enable this option. 

4. Enter the desired logging interval and indicate a time unit of either seconds (Sec) or minutes (Min). Logging 
Hours indicates how much data can be stored at the selected interval. 

5. Click Set to save the changes or click Cancel to exit without changing the settings 

DriveRight Settings: Verify DriveRight Calibration 

The Calibrate DriveRight dialog box allows you to verify DriveRight calibration settings.  

DriveRights can be installed on a vehicle using one of two installation methods: 

•  VSS (vehicle speed sensor) Installation  

•  Reed Switch Installation 

To verify the  DriveRight console calibration: 

1. Click on DriveRight Settings from the DriveRight Menu. 

2. Select Verify DriveRight Calibration from the drop-down menu. A DriveRight Calibration Message dialog box is 
displayed. 

3. Click OK, Set or Cancel to continue, depending on the displayed message. The Calibrate DriveRight dialog box 
is displayed. 

 

4. Select the type of installation method used by the DriveRight. 

•  We recommend that you not change the DriveRight calibration settings if it has been previously calibrated for 
the vehicle it is assigned to. 

•  OBD Adapter: If the DriveRight is using the OBD adapter, then select OBD Adapter as the installation method 
and DriveRight FMS will set the correct calibration. 

•  Reed Switch: If the DriveRight is using  a reed switch for the vehicle speed input, then it the DriveRight should 
be calibrated initially in the vehicle. The PPR for a reed switch is always “1”. 
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•  VSS: If the DriveRight uses the vehicle’s VSS as the speed input, you must specify the PPM for your vehicle. 
Depending on your selection, software calculates the PPR (pulses per reading) and calibration values and fills 
the edit boxes with them. You can select  the pulses per mile (PPM) from the drop down list or enter the PPM 
in the edit box if necessary. We recommend that you not change these settings if the DriveRight has been 
previously calibrated.  

5. Click Set to save changes to the calibration, or click cancel to exit without savingchanges. 

Downloading Guidelines 

You cannot download a DriveRight if any of the following conditions exist: 

•  DriveRight not present in the database. 

•  DriveRight not assigned to a Vehicle. 

•  Vehicle associated with this device does not have a default driver. 

Unless every thing is configured properly, you cannot download from the device. 

Note: The same conditions also apply to Host Mode and Palm Download. 

Download DriveRight 

The Download DriveRight command transfers trip data from the connected DriveRight device to the DriveRight 
database.  

To download your DriveRight: 

1. Connect your DriveRight console to your computer and make sure the DriveRight is "awake". Press the MODE 
key if there is nothing on the LCD display. 

2. Select Download DriveRight in the DriveRight Menu. The following Download Status box is displayed: 

Note: You will see the Cancel button only if you are downloading a DriveRight 600. 
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3. You may lose GPS data for earlier trips if the DriveRight console is not downloaded for an extended period of 
time. In this case you will see a warning message similar to this: 

 

4. If the calibration in the DriveRight console does not match the calibration in the database, you will see a warning 
message similar to this: 

 

5. When the data has finished downloading the following dialog box is displayed: 

 

6. Press Enter or click OK to continue. 

Download Palm 

DriveRight FMS offers a new feature to download data from multiple DriveRight devices from a Palm device. You will 
need the DriveRight Palm Download Kit, #8181, in order to use this command. 

Note: To download a DriveRight console data into the software using Palm Download, the DriveRight should be 
present in the database. If you try to download a DriveRight which is not present in the database, you will get an 
error message.  

To download your Palm: 

1. Select Download Palm in the DriveRight Menu.  
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2. The first time you download a Palm, the following dialog box is displayed. Select the directory which contains 
your Palm backup databases and click OK. 

 

3. Each time after the first time, when you use the Download Palm command, the following dialog box appears 
showing the selected Palm backup directory.  

 

4. Click Browse to select a different backup directory, click OK to use this displayed directory, or click Cancel to 
exit. 

5. If you click OK the Download Status dialog box is displayed.  
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6. When the data has finished downloading the Palm Download, Download Successful dialog box is displayed: 

 

7. Click OK to continue. 

Read Accident Log 

The Read Accident Log command will download accident log data from the connected DriveRight device, convert it to 
a text file, and display it using MS Notepad. 

To read the accident log: 

1. Select Read Accident Log in the DriveRight Menu. The accident log is displayed. 

Read Tamper Log 

The Read Tamper Log command will download Tamper Log data from the connected DriveRight device, convert it to a 
text file, and display it using MS Notepad. The Tamper Log holds the times and dates when the driver disconnected 
the DriveRight or tried to change the DriveRight Settings. 

Note: There must be a Settings PIN-Code in the unit to enable the logging of disconnect times.  

To read the tamper log: 

1. Select Read Tamper Log in the DriveRight Menu. The tamper log is displayed. 
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Set Time and Date 

Use this command to set the time and date on a DriveRight device. 

To set the time and date on a DriveRight: 

1. Select Set Time and Date from the DriveRight Menu. The Set Time and Date dialog box is displayed. 

 

2. Set the Date by either clicking the month, day or year in the edit box and entering the new information, or by 
clicking on the down arrow and selecting the date from the drop-down calendar. 

 

3.  Set the time by clicking on the hour, minute or second in the edit box and entering the new time. You can also 
adjust the time settings up and down using the up and down arrows in the edit box. 

4. Click on Set to change the time and date on the DriveRight unit or click on Cancel to exit the dialog box without 
changing the settings. 

Set Odometer 

Use this command to set the vehicle odometer reading in a DriveRight device. 

To set the odometer in a DriveRight: 

1. Select Set Odometer from the DriveRight Menu. The Set Odometer dialog box is displayed showing the current 
odometer reading. 
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2. You can now edit the vehicle’s odometer reading. 

3. Click on OK to update the odometer reading on the DriveRight unit or click on Cancel to exit the dialog box 
without changing the settings. 

Note: When you set the odometer DriveRight FMS updates the current odometer value of the vehicle assigned to 
this DriveRight and also adds a new entry in the Odometer Logs Table. 

Set Service Alarms 

Note: Available for the DriveRight Trip 500 AL only. 

Each vehicle needs a service check from time to time. With the Set Service Alarms option you can specify the 
Odometer Readings on which the vehicle should go in for service. After defining a Service Schedule you can assign it 
to a vehicle and load it into the DriveRight Trip 500AL using the Set Service Alarms command in the DriveRight menu. 
As soon as any defined odometer readings are reached, a warning signal is activated in the vehicle indicating the 
driver to bring his vehicle in for a service check, or call his service center for an appointment. 

To set a service alarm: 

1. Select Set Service Alarms from the DriveRight Menu. The Set Service Alarms dialog box is displayed. 
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2. Enter the odometer reading for a service alarm. 

3. Click the Add>> button to add the service alarm for that odometer reading. 

4. Click on an odometer reading to highlight it, then click the Delete button to remove a specific service alarm. 

5. Click the Clear All button to remove all service alarms. 

6. Click on Set to Device to update the service alarm settings on the DriveRight unit or click on Cancel to exit the 
dialog box without changing the settings. 

Set Drivers List 

This is a new feature added in DriveRight FMS. DriveRight 600 device provides a security feature which lets the 
operator set up to 100 drivers’ codes into the device to have access.  

To set the drivers list: 

1. Select Set Drivers List from the DriveRight Menu. The Set Drivers List dialog box is displayed. Drivers already 
assigned to this DriveRight are displayed in the right column. Drivers not assigned to this DriveRight are 
displayed in the left column. 

 

2. Click on a driver's name to select the driver, the click on the right arrows ">>" to move the driver to the "to set in 
DriveRight" list. 

3. To remove a driver from the DriveRight list, click on a driver's name to select the driver, then click on the left 
arrows "<<" to move the driver off the DriveRight list. 
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4. Click on Set to Device to update the drivers list on the DriveRight unit or click on Cancel to exit the dialog box 
without changing the drivers list. 

5. If you click on Set to Device, then you will see the following dialog box if the action is successful. Click on OK or 
press Enter to continue. 

 

Clear DriveRight 

The Clear DriveRight command clears all trip data in the connected DriveRight.  

To Clear your DriveRight: 

1. Select Clear DriveRight in the DriveRight Menu. The following DriveRight dialog box is displayed: 

2. Click Yes to clear the DriveRight device, click No to cancel the command. 
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CarChip Menu 

Use CarChip Menu commands for functions that require direct communications with the CarChip device.  

Note: The CarChip device must be connected to your computer in order to access the CarChip Menu commands. 

The following CarChip Menu commands are available: 

•  Add New CarChip 

•  CarChip Settings 

•  Download CarChip 

•  Set Time and Date 

•  Set CarChip LED State 

•  Display CarChip Memory 

•  Show CarChip Info 

•  Clear CarChip Memory 

Add New CarChip 

DriveRight FMS includes an Add CarChip Wizard to simplify adding CarChip devices to the database. Click on the 
links provided for each of the Add CarChip Wizard dialog boxes to see more detailed information. 

 Guidelines for Adding CarChips, Drivers and Vehicles 

Please refer to the following guidelines when adding new CarChip devices, drivers and vehicles. 

•  A CarChip device must be assigned to either a vehicle or a driver. 
•  Unlike DriveRight devices, a CarChip device can be easily switched from vehicle to vehicle, as long as all the 

vehicles provide a supported OBDII port. 

•  If a CarChip is assigned to a vehicle, the default driver of that vehicle will appear as the driver on all 
downloaded data from that CarChip. 

•  If a CarChip is assigned to a driver, then all data downloaded from that CarChip will be associated with that 
driver and the vehicle will be listed as UNKNOWN VEHICLE.  

•  If you just want to add a CarChip and you don’t yet have a vehicle or driver to assign, you can select 
"UNKNOWN VEHICLE". 

•  Based on your specific situation, you should carefully consider the options before assigning a CarChip to 
either a vehicle or driver. 

•  The Add New CarChip command opens a wizard that will guide you through the process of adding CarChips. 
It will also allow you to add drivers and vehicles if they are not already in the database. 

To add a new CarChip device: 

1. Select Add New CarChip from the CarChip Menu. The Add CarChip Wizard - Start dialog box is displayed. 

Note: The new CarChip device must be connected to your computer in order to add it to the DriveRight FMS 
database.  
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2. Click Next to continue or click Cancel to exit the Add CarChip Wizard. 

If you click Next, the Add CarChip Wizard - CarChip ID dialog box is displayed. 

 

3. Click Next to continue or click Cancel to exit the Add CarChip Wizard. 

If you click Next, the Add CarChip Wizard - Assign dialog box is displayed. 

Note: CarChip should be assigned to either a vehicle or driver. If it is assigned to a vehicle, the default driver of 
that vehicle appears on all the data downloaded. If a CarChip is assigned to a driver, then all data downloaded 
from that CarChip will be associated with that driver and the vehicle will be listed as UNKNOWN VEHICLE. This is 
useful if the driver uses multiple vehicles with the same CarChip. Based on your particular case, you should 
carefully choose between assigning a CarChip to a vehicle or a driver. 
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4. After assigning the CarChip to either  a vehicle or to a driver, Click Next to continue or click Cancel to exit the 
Add CarChip Wizard. 

5. If you are assigning the CarChip to a vehicle, the Vehicles browse window is displayed. Click on a vehicle in the 
browse window to highlight it, the click on the Select button to assign the CarChip to the selected vehicle. 

6. After selecting a vehicle from the browse window, the CarChip dialog box is displayed. Click Yes to continue or 
click No to return to the Vehicles browse window and make another selection. 

 

7. If the settings in the CarChip you are adding are different from the default CarChip settings in the database, you 
will see the following dialog box and be offered the opportunity to change the CarChip to your default settings. 
Click Yes to configure the CarChip with the default settings or click No to use the existing CarChip Settings.  

 

8. The next dialog box is the Add CarChip Wizard - Safety Settings. This shows the CarChip’s speed band, 
braking, and acceleration thresholds. 
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9. When you are satisfied with the safety settings,  click on Next to continue. Otherwise click Cancel to exit the Add 
CarChip Wizard. 

10. The next dialog box is the Add CarChip Wizard - Parameters. This shows the engine and vehicle performance 
parameters that will be logged by the CarChip.  

 

11. When you are satisfied with the parameter settings,  click on Next to continue. Otherwise click Cancel to exit the 
Add CarChip Wizard. 
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12. The next dialog box is the Review Settings For New CarChip. This dialog box allows you to review the 
identification, safety, and parameter settings for the new CarChip one last time before you add it to the 
database.  

 

13. When you are satisfied with the CarChip settings, click Set to add the CarChip to the database and to update 
the CarChip device settings. Select Cancel to exit the Add CarChip Wizard without adding the CarChip to the 
database or updating the CarChip device settings. 

14. When the CarChip has been successfully added to the database and the CarChip settings have been updated 
you will see the following Setup Result dialog box. 

 

15. Click OK to continue. 
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CarChip Settings 
Use the CarChip Settings command in the CarChip Menu to quickly view all CarChip settings, to add a CarChip to 

the database or to edit CarChip settings. 

1.  Select CarChip Settings from the CarChip Menu. The CarChip Device Settings dialog box is displayed. 

 

2. Make any desired changes.  

Note: If you change the vehicle assigned to a CarChip, the vehicle table will also be changed to reflect the new 
assignment. 

Note: If you assign a vehicle to a CarChip that had been previously assigned to a DriveRight device, the vehicle 
assignment for that DriveRight will be changed to "UNASSIGNED VEHICLE". 

3. Click the Defaults button to change the CarChip Hard Braking, Acceleration, Speed Bands, and Engine 
Parameters to the DriveRight FMS CarChip default settings. 

4. Click OK to save the changes or click Cancel to exit without saving. 

For more information on the DriveRight settings, see the following topics listed below: 

•  CarChip ID 

•  Hard Braking, Acceleration and Speed Bands 

•  Choose Parameters 

CarChip Identification Settings 

Each new CarChip device must be assigned an ID number. 

1. The CarChip ID dialog box shows the ID assigned to the CarChip device.  

•  You can change the assigned ID by clicking inside the text box and editing the number. 

•  Click on Browse CarChips to view CarChip ID’s in use at the current location. 

•  Click next to continue adding the new CarChip to the database or click Cancel to exit. 
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2. Click next to continue adding the new CarChip to the database or click Cancel to exit. 

CarChip Safety Settings 

Use the Add CarChip Wizard - Safety Settings dialog box to set speed, braking and acceleration thresholds for the 
CarChip device.  

1. Set Speed Band 3. Speed Band 3 is used as the speed limit in DriveRight FMS. 

2. Set the Hard Braking Threshold. The Hard Braking Threshold is used as the decel limit in DriveRight FMS. 

3. Set the Hard Acceleration Threshold. The Hard Acceleration Threshold is used as the accel limit in DriveRight 
FMS. 

4. Other speed bands and thresholds can be set but are not supported in DriveRight FMS 3.1. 

Note: If you are using CarChip and DriveRight devices, make sure both types of devices use the same safety 
settings. 
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5. When you are satisfied with the safety settings,  click on Next to continue. Otherwise click Cancel to exit the Add 
CarChip Wizard. 

CarChip Data Parameters 

Use the Add CarChip Wizard - Parameters dialog box to select up to four optional vehicle data parameters to be 
logged in addition to vehicle speed.  

1.  Select the vehicle data parameters you wish to log.  

2. Set the time interval for each parameter. Supported time intervals range from 5 seconds to 60 seconds. 

 

3. When you are satisfied with the parameter settings,  click on Next to continue. Otherwise click Cancel to exit the 
Add CarChip Wizard. 

List of Data Parameters 

The following vehicle data parameters can be logged by the CarChip data logger: 

•   Vehicle Speed 

•  Engine Speed 

•  Throttle Position 

•  Coolant Temperature 

•  Engine Load 

•  Intake Manifold Pressure 

•  Air Flow Rate 

•  Intake Air Temperature 

•  Timing Advance 

•  Fuel Pressure 

•  Fuel System Status 

•  Short Term Fuel Trim (B1) 
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•  Short Term Fuel Trim (B2) 

•  Long Term Fuel Trim (B1) 

•  Long Term Fuel Trim (B2) 

•  O2 Sensor Voltage (B1, S1) 

•  O2 Sensor Voltage (B1, S2) 

•  O2 Sensor Voltage (B1, S3) 

•  O2 Sensor Voltage (B1, S4) 

•  O2 Sensor Voltage (B2, S1) 

•  O2 Sensor Voltage (B2, S2) 

•  O2 Sensor Voltage (B2, S3) 

•  O2 Sensor Voltage (B2, S4) 

•  Battery Voltage 

Download CarChip 

Use this command to download data from your CarChip data logger into your computer. 

 You cannot download a CarChip device if any of the following conditions exist: 

•  CarChip not present in the database. 

•  CarChip not assigned to a Vehicle or to a Driver. 

•  Unless every thing is configured properly, you cannot download from the device. 

To download CarChip data: 

1. Connect your CarChip device to your computer. 

2. Choose Download CarChip from the CarChip menu. The Downloading Data dialog box appears. 

 

3. The dialog box disappears when the download is complete. 

4. Choose Cancel only if you wish to abort the download before it is finished. 

Set Time and Date 

Use this command to set the time and date on a CarChip device. 

To set the time and date on a CarChip: 

1. Select Set Time and Date from the CarChip Menu. The Set Time and Date dialog box is displayed. The dialog 
box shows your computer’s current time and date.  
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2. Set the Date by either clicking the month, day or year in the edit box and entering the new information, or by 
clicking on the down arrow and selecting the date from the drop-down calendar. 

 

3.  Set the time by clicking on the hour, minute or second in the edit box and entering the new time. You can also 
adjust the time settings up and down using the up and down arrows in the edit box. 

4. Click on Set to change the time and date on the CarChip device or click on Cancel to exit the dialog box without 
changing the settings. 

LED Status 

Use the CarChip LED Status command to view or change the CarChip LED status configuration. 

To change the CarChip Status LED: 

1. Choose Set CarChip LED State in the CarChip Menu. The CarChip LED Status dialog box is displayed showing 
the current state. 

 

2. Click Enable if you wish to turn on the CarChip Status LED. 
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3. Click Disable if you wish to turn off the CarChip Status LED. 

4. Click Set to configure the Status LED with the current setting or click Cancel to exit. 

Display CarChip Memory 

Use this command to show memory usage by the CarChip device. 

  

1. Choose Display CarChip Memory from the CarChip menu. The CarChip Memory dialog box appears. 

 

2. Click OK to close the dialog box.  

•  The amount of memory is displayed in kilobytes as well as the percentage of the available memory used. 

•  "Used" shows the amount of memory occupied by data. 

•  "Free" shows amount of memory available for new data. 

•  "Total" shows the total amount of memory in the data logger. 
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Show CarChip Info 

Use this command to show the fimware, bootware, and hardware version information for the currently connected 
CarChip device. 

1.  Choose Show CarChip Info from the CarChip menu. The CarChip Identity Info dialog box appears. 

 

2. Click OK to close the dialog box.  

Clear CarChip Memory 

The Clear CarChip Memory command clears all trip data in the connected CarChip.  

 To clear CarChip memory: 

1. Select Clear CarChip Memory in the CarChip Menu. The following CarChip dialog box is displayed: 

 

2. Click Yes to clear the CarChip device, click No to cancel the command. 
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Database Menu 

Use the Database Menu options to open the browse windows for individual database tables. In the browse window you 
can view and print records. You can also add, edit or delete records. 

Caution: Take extra care before deleting Company Location, DriveRight, CarChip, Driver or Vehicle records. 

The following Database Menu options are available: 

•  Company Locations 

•  DriveRights 

•  CarChips 

•  Driver Groups 

•  Drivers 

•  Fleets 

•  Vehicles 

•  Trips 

•  Accident Logs 

•  Tamper Logs 

•  Trip Addresses 

•  Days 

•  Download Dates 

•  GPS 

•  Odometer Logs 

•  Maintenance 

Company Locations 

Use this command to view and edit data for company locations. 

Caution: We strongly advise against changing a location name if you use FTP Export/FTP Import, since location 
name plays a very important role in these operations. In short, if you do any kind of centralized data collection 
do not alter location name. 

To view or edit data for company locations: 

1. Select the Company Locations command in the Database menu. The company locations browse window is 
displayed. 

2. Click the Add New button to add a new company location. 

3. Highlight a record in the browse window and click Edit, or double-click a record to update the company location 
information. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 
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Add Company Location 

Use the Add New command to create a new company location in the database. 

To add a new company location: 

1. Select the Company Locations command in the Database menu. The company locations browse window is 
displayed. 

2. Click the Add New button to add a new company location. 

 

3. The next available ID will be automatically assigned. Edit the location ID if desired.  

4. Enter the location name. 

5. Enter the location address. 

6. Click OK to save the new company location or click Cancel to exit without adding a new station. 

Edit Company Location 

Use the Edit command to change the information of an existing company location in the database. 

To edit a company location: 

1. Select the Company Locations command in the Database menu. The Company Locations browse window is 
displayed. 

2. Click on a record to select it. The selected record is highlighted. 

3. Click the Edit button to edit the selected record. The Edit Company Location dialog box is displayed. 

 

4. Edit the location name and address as desired. The location ID can not be edited. 

5. Click OK to save the changes or click Cancel to exit without saving. 



 86 

DriveRights 

Use the DriveRights command to view or edit data for installed DriveRight devices. 

Note: You can only change the assigned vehicle when editing a DriveRight record in the browse window. 

To view or edit DriveRight data: 

1. Select the DriveRights command in the Database menu. The DriveRights browse window is displayed. 

2. Highlight a record in the browse window and click Edit, or double-click a record to edit the information for a 
specific DriveRight device. 

3. Highlight a record in the browse window and click Delete to delete that record. 

4. Click Close to exit the browse window. 

5. Click Print to print the browse window. 

Edit DriveRight Setup 

Use the Edit command in the DriveRights browser to view or edit the DriveRight console settings in the database. 

Note: The only setting you can edit from this dialog box is the Vehicle ID. Use the DriveRight Settings Command 
in the DriveRight menu to edit other DriveRight console settings. 

To edit DriveRight settings: 

1. Select the DriveRights command in the Database menu. The DriveRights browse window is displayed. 

2. Click on a record to select it. The selected record is highlighted. 
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3. Click the Edit button to edit the selected record. The Edit DriveRight Setup dialog box is displayed. 

 

4. You can change the Vehicle ID by selecting a new ID from the drop-down list, if desired. 

5. Click OK to save the changes or click Cancel to exit without saving. 
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Print DriveRights 

Use the Print command in the DriveRights browse window to print DriveRight records. 

To print DriveRight records: 

1. Select the DriveRights command in the Database menu. The DriveRights browse window is displayed. 

2. Click the Print button. The Select DriveRights Fields to Print dialog box is displayed. 

 

3. To print all fields in the records, leave the Print All Fields box checked. 

4. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

5. You can click Clear All to de-select all fields, or click Set All to select all fields. 

6. Click OK to print or click Cancel to exit without printing. 

CarChips 

Use the CarChips command to view or edit data for installed CarChip devices. 

Note: You can only change the assigned vehicle or the assigned driver when editing a CarChip record in the 
database browse window. 

To view or edit CarChip data: 
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1. Select the CarChip command in the Database menu. The CarChip browse window is displayed. 

2. Click the Add New button to add a new CarChip to the database. This button starts the Add New CarChip 
Wizard. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the information for a 
specific CarChip device. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 

Edit CarChip Setup 

Use the Edit command in the CarChip browse window to view or edit the CarChip device settings in the database. 

Note: The only settings you can edit from this dialog box are the Vehicle ID or Driver ID. Use the CarChip Settings 
Command in the CarChip menu to edit other CarChip device settings. 

To edit CarChip settings: 

1. Select the CarChips command in the Database menu. The CarChips browse window is displayed. 

2. Click on a record to select it. The selected record is highlighted. 

3. Click the Edit button to edit the selected record. The Edit CarChip Setup dialog box is displayed. 

 

4. You can change the Vehicle ID or Driver Name by selecting a new ID or name from the drop-down list, if 
desired. 

5. Click OK to save the changes or click Cancel to exit without saving. 
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Driver Groups 

Use the Driver Groups command in the Database menu to view or edit driver group data.  

To view or edit driver group data: 

1. Select the Driver Groups command in the Database menu. The Driver Groups browse window is displayed. 

2. Click the Add New button to add a new driver group to the database. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the record. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 

Add Drivers Group 

Use the Add New command in the Driver Groups browser to add a new drivers group to the database. 

To add a new drivers group: 

1. Select the Driver Groups command in the Database menu. The Driver Groups browse window is displayed. 

2. Click the Add New button to add a new drivers group. The Add Drivers Group dialog box is displayed. 

 

3. Enter the new record information. 

4. Click OK to save the new record or click Cancel to exit without adding a new record. 

Edit Drivers Group 

Use the Edit command in the Driver Groups browse window to edit a drivers group record in the database. 

To edit a drivers group record: 

1. Select the Driver Groups command in the Database menu. The Driver Groups browse window is displayed. 

2. Click on a record to select it. The selected record is highlighted.. 
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3. Click the Edit button to edit the selected record. The Edit Drivers Group dialog box is displayed. 

 

4. Edit the record as desired. 

5. Click OK to save the changes or click Cancel to exit without saving. 

Drivers 

Use the Drivers command in the Database menu to view or edit driver data.  

To view or edit driver data: 

1. Select the Drivers command in the Database menu. The Drivers browse window is displayed. 

2. Click the Add New button to add a new driver to the database. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the record. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 

Add Driver 

Use the Add New command in the Drivers browser to add a new driver to the database. 

To add a new driver: 

1. Select the Drivers command in the Database menu. The Drivers browse window is displayed. 
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2. Click the Add New button to add a new driver. The Add Driver dialog box is displayed. 

 

3. Enter the new record information. 

4. Click OK to save the new record or click Cancel to exit without adding a new record. 

Edit Driver 

Use the Edit command in the Drivers browse window to edit a driver record. 

To edit a driver record: 

1. Select the Drivers command in the Database menu. The Drivers browse window is displayed. 

2. Click on a record to select it. The selected record is highlighted. 
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3. Click the Edit button to edit the selected record. The Edit Driver dialog box is displayed. 

 

4. Edit the record as desired. 

5. Click OK to save the changes or click Cancel to exit without saving. 

Print Drivers 

Use the Print command in the Drivers browse window to print driver records. 

To print driver records: 

1. Select the Drivers command in the Database menu. The Drivers browse window is displayed. 
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2. Click the Print button. The Select Drivers Fields to Print dialog box is displayed. 

 

3. To print all fields in the records, leave the Print All Fields box checked. 

4. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

5. You can click Clear All to de-select all fields, or click Set All to select all fields. 

6. Click OK to print or click Cancel to exit without printing. 

Fleets 

Use the Fleets command in the Database menu to view or edit fleet data.  

To view or edit fleet data: 

1. Select the Fleets command in the Database menu. The Fleets browse window is displayed. 

2. Click the Add New button to add a new fleet to the database. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the record. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 

Add Fleets 

Use the Add New command in the Fleets browser to add a new fleet to the database. 

To add a new fleet: 
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1. Select the Fleets command in the Database menu. The Fleets browse window is displayed. 

2. Click the Add New button to add a new fleet. The Add Fleets dialog box is displayed. 

 

3. Enter the new record information. 

4. Click OK to save the new record or click Cancel to exit without adding a new record. 

Edit Fleets 

Use the Edit command in the Fleets browse window to edit a fleet record. 

To edit a fleet record: 

1. Select the Fleets command in the Database menu. The Fleets browse window is displayed. 

2. Click on a record to select it. The selected record is highlighted. 

3. Click the Edit button to edit the selected record. The Edit Fleets dialog box is displayed. 

 

4. Edit the Fleet Name as desired. 

5. Click OK to save the changes or click Cancel to exit without saving. 

Vehicles 

Use the Vehicles command in the Database menu to view or edit vehicle data.  

To view or edit vehicle data: 

1. Select the Vehicles command in the Database menu. The Vehicles browse window is displayed. 
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2. Click the Add New button to add a new vehicle to the database. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the record. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 

Add Vehicle 

Use the Add New command in the Vehicle browser to add a new vehicle to the database. 

To add a new vehicle: 

1. Select the Vehicle command in the Database menu. The Vehicle browse window is displayed. 

2. Click the Add New button to add a new vehicle. The Add Vehicles dialog box is displayed. 

 

3. Enter the new vehicle information. 

Note: You do not need to assign the vehicle to a DriveRight console at this point. You will assign the vehicle in the 
Add New DriveRight Wizard. 

4. Click OK to save the record or click Cancel to exit without saving. 
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Edit Vehicle 

Use the Edit command in the Vehicles browse window to edit a vehicle record. 

To edit a vehicle record: 

1. Select the Vehicles command in the Database menu. The Vehicles browse window is displayed. 

2. Click on a record to select it for editing. The selected record is highlighted. 

3. Click the Edit button to edit the selected record. The Edit Vehicle dialog box is displayed. 

 

4. Edit the record as desired. 

5. If you are changing the Default Driver to a new driver, you can click the Add Driver button to add a new driver 
the to database. 

6. Click OK to save the changes or click Cancel to exit without saving. 
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Print Vehicles 

Use the Print command in the Vehicles browse window to print vehicle records. 

To print vehicle records: 

1. Select the Vehicles command in the Database menu. The Vehicles browse window is displayed. 

2. Click the Print button. The Select Vehicles Fields to Print dialog box is displayed. 

 

3. To print all fields in the records, leave the Print All Fields box checked. 

4. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

5. You can click Clear All to de-select all fields, or click Set All to select all fields. 

6. Click OK to print or click Cancel to exit without printing. 

Trips 

Use the Trips command in the Database menu to view or edit trip data. 

To view or edit trip data:  

1. Select the Trips command in the Database menu. The Filter For Trips dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Trips browse window or click Cancel to exit the dialog box without opening the browse 
window. 
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4. Click Add New to create a new record. 

5. Click Set Filter to change the filter for the displayed records. 

6. Highlight a specific record and click Edit to view or edit that record in the Update window. 

7. Highlight a specific record and click Delete to delete the record. 

8. Click Close to exit the browse window. 

9. Click Print to print the browse window. 

10. Click Export GPS to export GPS data from the trips displayed in the browse window. 

Note: Press Control-D to export GPS data for the entire day of the currently selected record. 

Filter for Trips 

The Trips filter dialog box is displayed when you select the Trips command in the Database menu or when you select 
the Set Filter command when you are exporting data. The trips filter allows you to select trip data based on the options 
you choose in the filter dialog box. 

To filter trip data:  

1. Select the Trips command in the Database menu. The Filter For Trips dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Click Veh ID/Lic and select an ID from the drop-down list to select the records for a specific vehicle. 

6. Check Trips Between and select a Start Date and End Date to select records for a specific time period. 

7. To select records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 
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8. Click OK to set the filter or click Cancel to exit the dialog box. 

Add Trip 

Use the Add New command in the Trips browser to add a new trip to the database. 

To add a new trip: 

1. Select the Trips command in the Database menu. The Filter for Trips browser is displayed. 

2. After selecting your filter options, click OK to display the Trips browser. 

3. Click the Add New button to add a new trip. The Add Trips dialog box is displayed. 

 

4. Enter the new record information. 

5. Click OK to save the new record or click Cancel to exit without adding a new record. 

 Edit Trip 

Use the Edit command in the Trips browse window to edit a trip record. 

To edit a trip record: 

1. Select the Trips command in the Database menu. The Filter for Trips dialog box is displayed. 

2. After selecting your filter options, click OK to display the Trips browse window. 

3. Click on a record to select it for editing. The record is highlighted. 
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4. Click the Edit button to edit the selected record. The Edit Trip dialog box is displayed. 

 

5. Edit the record information as desired 

6. Click OK to save the record or click Cancel to exit without saving. 

Print Trip Records 

Use the Print command in the Trips browse window to print trip records. 

To print trip records: 

1. Select the Trips command in the Database menu. The Filter for Trips browse window is displayed. 

2. After selecting your filter options, click OK to display the Trips browse window. 
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3. Click the Print button. The Select Trips Fields to Print dialog box is displayed. 

 

4. To print all fields in the records, leave the Print All Fields box checked. 

5. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

6. You can click Clear All to de-select all fields, or click Set All to select all fields. 

7. Click OK to print or click Cancel to exit without printing. 

Accident Logs 

Use the Accident Logs command in the Database menu to open the Accident Logs browse window.  

To open the Accident Logs browse window: 

1. Select the Accident Logs command in the Database menu. The Filter For Accident Logs dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Accident Log browse window or click Cancel to exit the dialog box without opening the 
browse window. 

4. Click Set Filter to change the filter for the displayed accident logs. 

5. Highlight a specific accident record and click Edit to view that record in the Update Accident Log window. 
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6. Highlight a specific accident record and click Delete to delete a specific accident log record. 

7. Click Close to exit the browse window. 

8. Click Print to print the browse window. 

Filter for Accident Logs 

The Filter For Accident Logs dialog box is displayed when you select the Accident Logs command in the Database 
menu or when you select the Set Filter command when you are exporting data. The accident log filter allows you to 
select data based on the options you choose in the filter dialog box. 

To filter accident log data:  

1. Select the Accident Logs command in the Database menu. The Filter For Accident Logs dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check Accident Logs Between and select a Start Date and End Date to select records for a specific time period. 

6. Click OK to set the filter or click Cancel to exit the dialog box. 

Edit Accident Log 

Use the Edit command in the Accident Log browse window to edit an accident log record. 

To edit an accident log record: 

1. Select the Accident Logs command in the Database menu. The Filter for Accident Logs dialog box is displayed. 

2. After selecting your filter options, click OK to display the Accident Logs browse window. 

3. Click on a record to select it. The selected record is highlighted. 

4. Click the Edit button to edit the selected record. The Edit Accident Log dialog box is displayed. 
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5. Enter the Reason for Log if desired. No other part of the accident log record can be edited.  

6. Click OK to save the changes or click Cancel to exit without saving. 

Tamper Logs 

Use the Tamper Logs command in the Database menu to view tamper log data. 

To view the Tamper Log data: 

1. Select the Tamper Logs command in the Database menu. The Filter For Tamper Logs dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Tamper Logs browser window or click Cancel to exit the dialog box without opening the 
browser window. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view that record in the Update window. 

Note: You cannot edit tamper log data. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the browser window. 

8. Click Print to print the browser window. 



 105

Filter for Tamper Logs 

The Tamper Logs filter dialog box is displayed when you select the Tamper Logs command in the Database menu or 
when you select the Set Filter command when you are exporting data.. The tamper logs filter allows you to select 
tamper log records based on the options you choose in the filter dialog box. 

To filter tamper log data:  

1. Select the Tamper Logs command in the Database menu. The Filter For Tamper Logs dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check Tamper Logs Between and select a Start Date and End Date to select records from a specific time 
period. 

6. Click OK to set the filter or click Cancel to exit the dialog box without opening the browser window. 

Edit Tamper Log 

Use the Edit command in the Tamper Log browse window to view a tamper log record. 

Note: Tamper Log records cannot be edited. 

To edit a tamper log record: 

1. Select the Tamper Logs command in the Database menu. The Filter for Tamper Logs dialog box is displayed. 

2. After selecting your filter options, click OK to display the Tamper Logs browse window 

3. Click on a record to select it for editing. The selected record is highlighted. 

4. Click the Edit button to display the selected record. The Edit Tamper Log dialog box is displayed. 
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5. Click OK or Cancel to exit. 

Trip Addresses 

Use the Trip Addresses command in the Database menu to view or edit trip address data.  

To view or edit trip address data: 

1. Select the Trip Addresses command in the Database menu. The Trip Addresses browse window is displayed. 

2. Click the Add New button to add a new trip address to the database. 

3. Highlight a record in the browse window and click Edit, or double-click a record to edit the record. 

4. Highlight a record in the browse window and click Delete to delete that record. 

5. Click Close to exit the browse window. 

6. Click Print to print the browse window. 
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Add Trip Address 

Use the Add New command in the Trip Addresses browser to add a new trip address to the database. 

To add a new trip address: 

1. Select the Trip Addresses command in the Database menu. The Trip Addresses browser is displayed. 

2. Click the Add New button to add a new trip address. The Add Trip Addresses dialog box is displayed. 

 

3. Enter the new record information. 

4. Click OK to save the new record or click Cancel to exit without adding a new record. 

Edit Trip Address 

Use the Edit command in the Trips browse window to edit a trip address record. 

To edit a trip address record: 

1. Select the Trip Address command in the Database menu. The Trip Addresses browse window is displayed. 

2. Click on a record to select it for editing. The selected record is highlighted. 
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3. Click the Edit button to edit the selected record. The Edit Trip Addresses dialog box is displayed. 

 

4. Edit the record as desired. 

5. Click OK to save the record or click Cancel to exit without saving. 

Days 

Use the Days command in the Database menu to view or edit day data. Day data summarizes vehicle information by 
day. As the day data is composed from the trip database in the case of Trip Computer, Trip 500AL or DriveRight 600, 
you cannot add any data in this dialog. While downloading data from a DriveRight, the day data will be processed and 
placed into the database.  

To view or edit the day data: 

1. Select the Days command in the Database menu. The Filter For Days dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the Days browse window or click Cancel to exit the dialog box without opening the browse 
window. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view that record in the Update window. 
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6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the browse window. 

8. Click Print to print the browse window. 

Filter for Days 

The Filter For Days dialog box is displayed when you select the Days command in the Database menu or when you 
select the Set Filter command when you are exporting data. The days filter allows you to select data based on the 
options you choose in the filter dialog box. 

To filter days data:  

1. Select the Days command in the Database menu. The Filter For Days dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check Days Between and select a Start Date and End Date to select records for a specific time period. 

6. To select records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

7. Click OK to set the filter or click Cancel to exit the dialog box. 

  

Edit Days 

Use the Edit command in the Days browse window to edit a days record. 

To edit a days record: 

1. Select the Days command in the Database menu. The Filter for Days dialog box is displayed. 



 110

2. After selecting your filter options, click OK to display the Days browse window. 

3. Click on a record to select it. The selected record is highlighted. 

4. Click the Edit button to edit the selected record. The Edit Days dialog box is displayed. 

 

5. Enter the new record information. 

6. Click OK to save the changes or click Cancel to exit without saving. 

Print Days 

Use the Print command in the Days browser to print days records. 

To print days records: 

1. Select the Days command in the Database menu. The Filter for Days dialog box is displayed. 

2. After selecting your filter options, click OK to display the Days browse window. 

3. Click the Print button. The Select Days Fields to Print dialog box is displayed. 
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4. To print all fields in the records, leave the Print All Fields box checked. 

5. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

6. You can click Clear All to de-select all fields, or click Set All to select all fields. 

7. Click OK to print or click Cancel to exit without printing. 

Download Dates 

Use the Download Dates command in the Database menu to view or edit the download dates data.  

To view or edit the download dates data: 

1. Select the Download Dates command in the Database menu. The Filter For Download Dates dialog box is 
displayed. 

2. Select your desired filter options.  

3. Click OK to show the Download Dates browse window or click Cancel to exit the dialog box without opening the 
browse window. 

4. Click Add New to create a new record. 

5. Click Set Filter to change the filter for the displayed records. 
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6. Highlight a specific record and click Edit to view that record in the Update window. 

7. Highlight a specific record and click Delete to delete that record. 

8. Click Close to exit the browse window. 

9. Click Print to print the browse window. 

Filter for Download Dates 

The Filter For Download Dates dialog box is displayed when you select the Download Dates command in the 
Database menu or when you select the Set Filter command when you are exporting data. The Download Dates filter 
allows you to select data based on the options you choose in the filter dialog box. 

To filter Download Dates data:  

1. Select the Download Dates command in the Database menu. The Filter For Download Dates dialog box is 
displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check Download Dates Between and select a Start Date and End Date to select records for a specific time 
period. 

6. Click OK to set the filter or click Cancel to exit the dialog box. 

Add Download Dates 

Use the Add New command to add a record to the Download Dates database. 

To add a new download date: 

1. Select the Download Dates command in the Database menu. The Download Dates browse window is displayed. 

2. Click the Add New button to add a download date record. The Add Download Dates dialog box is displayed. 
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3. Enter the new record information. 

4. Click OK to save the new record or click Cancel to exit without adding a new record. 

Edit Download Dates 

Use the Edit command in the Download Dates browse window to edit a download date record. 

To edit a download date record: 

1. Select the Download Dates command in the Database menu. The Filter for Download Dates dialog box is 
displayed. 

2. After selecting your filter options, click OK to display the Download Dates browser. 

3. Click a record to select it. The selected record is highlighted. 

4. Click the Edit button to edit the selected record. The Edit Download Dates dialog box is displayed. 

 

5. Edit the record as desired. 

6. Click OK to save the changes or click Cancel to exit without saving. 

GPS 

Use the GPS command in the Database menu to view or edit GPS data.  
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To view or edit GPS data: 

1. Select the GPS command in the Database menu. The Filter For GPS dialog box is displayed. 

2. Select your desired filter options.  

3. Click OK to show the GPS browse window or click Cancel to exit the dialog box. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to view the selected record. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the browser window. 

8. Click Print to print the browser window. 

Filter for GPS 

The Filter For GPS dialog box is displayed when you select the GPS command in the Database menu or when you 
select the Set Filter command when you are exporting data. The GPS filter allows you to select data based on the 
options you choose in the filter dialog box. 

To filter GPS data:  

1. Select the GPS command in the Database menu. The Filter For GPS dialog box is displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Check GPS Between and select a Start Date and End Date to select records for a specific time period. 

6. To select records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

7. Click OK to set the filter or click Cancel to exit the dialog box. 
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Edit GPS 

Use the Edit command in the GPS browse window to view a GPS record. 

Note: GPS records cannot be edited. 

To view a GPS record: 

1. Select the GPS command in the Database menu. The Filter for GPS dialog box is displayed. 

2. After selecting your filter options, click OK to display the GPS browser. 

3. Click on a record to select it. The selected record is highlighted. 

4. Click the Edit button to view the selected record. The Edit GPS dialog box is displayed. 

 

5. Click OK or Cancel to exit. 

Print GPS 

Use the Print command in the GPS browse window to print GPS records. 

To print GPS records: 

1. Select the GPS command in the Database menu. The Filter for GPS dialog box is displayed. 

2. After selecting your filter options, click OK to display the GPS browse window. 
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3. Click the Print button. The Select GPS Fields to Print dialog box is displayed. 

 

4. To print all fields in the records, leave the Print All Fields box checked. 

5. To print selected fields, check the Select fields to print box, then check each of the fields to be printed. 

6. You can click Clear All to de-select all fields, or click Set All to select all fields. 

7. Click OK to print or click Cancel to exit without printing. 

Odometer Logs 

Use the Odometer Logs command in the Database menu to view or edit odometer log data.  

To view or edit odometer log data: 

1. Select the Odometer Logs command in the Database menu. The Filter For Odometer Logs dialog box is 
displayed. 

2. Select your desired filter options.  

3. Click OK to show the Odometer Logs browser window or click Cancel to exit the dialog box without opening the 
browser window. 

4. Click Set Filter to change the filter for the displayed records. 

5. Highlight a specific record and click Edit to edit the selected record. 

6. Highlight a specific record and click Delete to delete that record. 

7. Click Close to exit the browser window. 

8. Click Print to print the browser window. 
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Filter for Odometer Logs 

The Filter For Odometer Logs dialog box is displayed when you select the Odometer Logs command in the Database 
menu or when you select the Set Filter command when you are exporting data. The odometer logs filter allows you to 
select data based on the options you choose in the filter dialog box. 

To filter odometer log data:  

1. Select the Odometer Logs command in the Database menu. The Filter For Odometer Logs dialog box is 
displayed. 

 

2. Click the Browse All to select all records. 

3. Click Driver Name and select a driver from the drop-down list to select the records for a specific driver. 

4. Click DriveRight ID and select an ID from the drop-down list to select the records for a specific DriveRight. 

5. Click OK to set the filter or click Cancel to exit the dialog box. 

Edit Odometer Log 

Use the Edit command in the Odometer Logs browse window to edit an odometer log record. 

To edit an odometer log record: 

1. Select the Odometer Logs command in the Database menu. The Filter for Odometer Logs dialog box is 
displayed. 

2. After selecting your filter options, click OK to display the Odometer Logs browse window. 

3. Click on a record to select it for editing. The selected record is highlighted. 
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4. Click the Edit button to edit the selected record. The Edit Odometer Log dialog box is displayed. 

 

5. Edit the record as desired. 

6. Click OK to save the changes or click Cancel to exit without saving. 

Maintenance 

Use the Maintenance command in the Database menu to delete data from the database. Although there are several 
opportunities to delete data in other parts of the program, this option is meant to delete large portions of data at once. 
Use this option carefully.  

Note: Before the data is deleted, you will be prompted to confirm the deletion. 

To delete data from the database: 

1. Select the Maintenance command in the Database menu.  

2. Select the database table to delete records from the drop-down list. A delete filter dialog box appears.  

•  Filter For Deleting Trips 

•  Filter For Deleting Accident Logs 

•  Filter For Deleting Tamper Logs 

•  Filter For Deleting Days 

•  Filter For Deleting Download Dates 

•  Filter For Deleting GPS 

•  Filter For Deleting Odometer Logs 

3. Enter the filter information for the records to be deleted. 

4. Click OK to delete the selected records or click Cancel to exit without deleting records. If you click OK to delete 
data, you will be prompted to confirm the deletion. 

5. To confirm the deletion, click Yes in the message box or click No to cancel and return to the delete filter dialog 
box. 

Filter For Deleting Accident Logs 

Use this filter to select Accident Log data to be deleted. 



 119

To select Accident Log data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Accident Log in the drop-down menu. The Filter For Deleting 
Accident Log dialog box is displayed. 

 

3. Click the Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Check Accident Logs Between and select a Start Date and End Date to delete records from a specific time 
period. 

7. Click OK to delete the selected records or click Cancel to exit the dialog box. 
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Filter For Deleting Days 

Use this filter to select Days data to be deleted. 

To select Days data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Days in the drop-down menu. The Filter For Deleting Days 
dialog box is displayed. 

 

3. Click the Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Check Days Between and select a Start Date and End Date to delete records from a specific time period. 

7. To delete records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

8. Click OK to delete the selected records or click Cancel to exit the dialog box. 

Filter For Deleting Download Dates 

Use this filter to select Download Dates records for deletion. 

To select Download Dates data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Download Dates in the drop-down menu. The Filter For 
Deleting Download Dates dialog box is displayed. 
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3. Click the Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Check Download Dates Between and select a Start Date and End Date to delete records for a specific time 
period. 

7. Click OK to delete the selected records or click Cancel to exit the dialog box. 
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Filter For Deleting GPS 

Use this filter to select GPS data to be deleted. 

To select GPS data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select GPS in the drop-down menu. The Filter For Deleting GPS 
dialog box is displayed. 

 

3. Click the Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Check GPS Between and select a Start Date and End Date to delete records from a specific time period. 

7. To delete records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

8. Click OK to delete the selected records or click Cancel to exit the dialog box. 

Filter For Deleting Odometer Logs 

Use this filter to select Odometer Log data to be deleted. 

To select odometer log data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Odometer Logs in the drop-down menu. The Filter For 
Deleting Odometer Logs dialog box is displayed. 
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3. Click Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Click OK to delete the selected records or click Cancel to exit the dialog box. 

Filter For Deleting Tamper Logs 

Use this filter to select Tamper Log data to be deleted. 

To select tamper log data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Tamper Logs in the drop-down menu. The Filter For Deleting 
Tamper Logs dialog box is displayed. 

 

3. Click the Delete All to delete all records. 
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4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Click Veh ID/Lic and select an ID from the drop-down list to delete the records for a specific vehicle. 

7. Check Tamper Logs Between and select a Start Date and End Date to delete records from a specific time 
period. 

8. Click OK to delete the selected records or click Cancel to exit the dialog box. 

Filter For Deleting Trips 

Use this filter to select trip records for deletion. 

To select trip data for deletion:  

1. Select the Maintenance command in the Database window. 

2. Select the Delete Data command and then select Trips in the drop-down menu. The Filter For Deleting Trips 
dialog box is displayed. 

 

3. Click the Delete All to delete all records. 

4. Click Driver Name and select a driver from the drop-down list to delete the records for a specific driver. 

5. Click DriveRight ID and select an ID from the drop-down list to delete the records for a specific DriveRight. 

6. Click Veh ID/Lic and select an ID from the drop-down list to delete the records for a specific vehicle. 

7. Check Trips Between and select a Start Date and End Date to delete records from a specific time period. 

8. To delete records with a high speed over a specified speed, enter a speed in the High Speed >= text box. 

9. Click OK to delete the selected records or click Cancel to exit the dialog box. 
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Reports Menu 

DriveRight can produce a number of useful reports. The reports can be displayed on the screen or printed. 

The following reports are available: 

•  Accident Log Report 

•  Driver Performance Score 

•  Exception Reports 

•  Database Reports 

•  Usage Report 

•  Trip Summary Report 

•  Tamper Logs Report 

•  Odometer Report 

•  Relationship Report 

•  Days Since Last Download Report 

Accident Log Report 

The Accident Log report allows you to view, print, or export the contents of the Accident Log.  

To create an Accident Log Report: 

1. Select Accident Log Report from the Reports Menu. The Accident Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the DriveRight ID to be used in the report. 
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4. Select the Start Date and the End Date for the accident logs to be listed in the report. 

5. Select the type of output for the report: Excel or Report Viewer. 

6. Click OK to create the report or click Cancel to exit the dialog box. 

Driver Performance Score 

The Driver Performance Score report allows you to view, print, email, or export the Driver Performance Score.  

To create the Driver Performance Score Report: 

1. Select Driver Performance Score Report from the Reports Menu. The Driver Performance Score dialog box is 
displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Start Date and the End Date for the driver performance data to be included in the report. 

4. Use the Sort by options to sort the output by current score, cumulative score, or the driver’s name.  If you sort 
by current score and choose "Use Color", the coloring is done based on the current score.  If you sort by 
cumulative score, the coloring is done based on cumulative score.  If you sort by driver’s name, coloring is done 
based on the current score. 

5. Use the "Compare with last ___ months" text box to enter the number of months back from the start date that 
you want to include in the calculation of the "cumulative" score.  The cumulative score will be calculated from 
the start date minus X months up to and including the end date. 

6. Select the type of output for the report: Excel, Report Viewer, or Email. Click Use Color to enable color printing. 

7. Check "Use DriveRight Console Method" box to calculate the Driver Performance Score using the same method 
used in the DriveRight console. If the box is left unchecked, the "Default Software Method" is used. 
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8. Click on the Formula button to view or change the Driver Performance Score parameters. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

Driver Performance Score Formula 

Use this dialog box to edit the parameters used in the Driver Performance Score: 

To modify the Driver Performance Score parameters: 

1. Select Driver Performance Score Report from the Reports Menu. The Driver Performance Score dialog box is 
displayed. 

2. Click on the Formula button in the lower right corner of the Driver Performance Score dialog box. The Score 
Parameters dialog box is displayed. 

 

3. Edit the parameters as desired. 

4. Click on the Defaults button at any time to restore the default parameters. 
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5. When you are finished modifying the parameters, click OK to save the changes or click Cancel to exit the dialog 
box without saving any changes. 

Exception Reports 

Exception Reports can be printed for Vehicles, Drivers, and Trip Addresses. 

•  Excessive Speed Report 

•  Night Driving Report 

•  Hard Braking Report 

•  Time Over Speed Report 

Excessive Speed Report 

Use the Excessive Speed Report to identify drivers that exceed a set speed. 

To create an Excessive Speed Report: 

1. Select Excessive Speed Report from the Exception Reports command in the Reports Menu. The Excessive 
Speed Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sort By criteria by clicking next to either Driver Name or Date. 
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4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 

5. If you are creating the report for specific drivers, select the driver’s name in the list.  

•  Click once to select the name and click a second time to clear the name.  

•  Multiple drivers can be selected for the report. 

6. Select Trips Between to create a report that only lists trips taken between specific dates. If you select Trips 
Between, then indicate the Start Date and End Date for the reported trips. 

7. Enter the Top Speed in the edit box. Trips with speeds in excess of the top speed will be listed in the report. 

8. Click OK to create the report or click Cancel to exit the dialog box. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Hard Braking Report 

Use the Hard Braking Report to identify drivers that use the brakes excessively. 

To create a Hard Braking Report: 

1. Select Hard Braking from the Exception Reports command in the Reports Menu. The Hard Braking Report 
dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sort By criteria from the drop-down list: Driver name, Date, Decel count and Decel count rate. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 

5. If you selected Driver Names, click on the names of drivers to be included in the report. 
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•  Click once to select the name. You can click a second time to clear the name.  

•  Multiple drivers can be selected for the report. 

6. In the Choose Limit box you can configure the report to include all trips with at least the indicated number of 
deceleration counts or you can include the trips for all drivers that exceed the minimum number of deceleration 
counts during the chosen date interval. 

7. In the Choose Interval box you can set start and end dates for the trips to be included in the report. 

8. Click OK to create the report or click Cancel to exit the dialog box. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Night Driving Report 

Use the Night Driving Report to list trips that occur during user-defined nighttime hours. Use this report to track 
unauthorized night driving.  

To create a Night Driving Report: 

1. Select Night Driving from the Exception Reports command in the Reports Menu. The Night Driving Report 
dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sorting criteria by clicking next to either Driver Name or Date. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 

5. If you are creating the report for specific drivers, click on the drivers name in the list.  
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•  Click once to select the name and click a second time to clear the name.  

•  Multiple drivers can be selected for the report. 

6. In the Define Night box enter the night times for the report. Night will begin at the After time. Night will end at the 
Before time. 

7. In the Choose Limit box you can configure the report to list trips with at least the minimum amount of night 
driving time that you specify for a single trip, or you can choose to list trips for drivers with at least the minimum 
amount of total night driving time during the chosen date interval.  

8. In the Choose Interval box you can set start and end dates for the trips to be included in the report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Time Over Speed 

Use the Time Over Speed Report to identify drivers that speed excessively. 

To create a Time Over Speed Report: 

1. Select Time Over Speed from the Exception Reports command in the Reports Menu. The Time Over Speed 
Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sort By criteria from the drop-down list: Driver name, Date, Time over speed and % of time over 
speed.. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 
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5. If you selected Driver Names, click on the names of drivers to be included in the report. 

•  Click once to select the name. You can click a second time to clear the name.  

•  Multiple drivers can be selected for the report. 

6. In the Choose Interval box you can set start and end dates for the trips to be included in the report. 

7. In the Choose Limit box you can configure the report to include all single trips with at least the amount of time 
over the speed limit or you can configure the report to show total time over the speed limit.. 

8. Click OK to create the report or click Cancel to exit the dialog box. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Database Reports 

Database Reports can be printed for Vehicles, Drivers, and Trip Addresses. 

•  Vehicles Report 

•  Trip Addresses Report 

•  Drivers Report 

Vehicles Report 

To print a Vehicles Report: 

1. Select Vehicles Report from the Database command in the Reports Menu. The Vehicles Report dialog box is 
displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 
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3. Select the Sorting criteria by clicking next to the desired parameter. 

4. Select View for to display vehicles from a specific fleet or of a specific type. 

5. Click OK to create the report or click Cancel to exit the dialog box. 

6. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Trip Addresses Report 

The Trip Addresses Report displays a list of the trip addresses in your database. 

To view the Trip Addresses Report: 

1. Select Trip Addresses Report from the Database command in the Reports Menu. The Trip Addresses Report is 
displayed. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Drivers Report 

To print a Drivers Report: 

1. Select Drivers Report from the Database command in the Reports Menu. The Drivers Report dialog box is 
displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sorting criteria by clicking next to the desired parameter. 

4. Select View by to display drivers from a specific group. 

5. Click OK to create the report or click Cancel to exit the dialog box. 

6. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 
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Usage Report 

The Usage Report provides a quick and easy-to-read summary of driver or vehicle mileage. 

To create a Usage Report: 

1. Select Usage Report from the Reports Menu. The Usage Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sorting criteria from the drop-down list. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 

5. If you are creating a report for specific drivers, click on the drivers name in the list.  

•  Click once to select the driver and click a second time to de-select the driver.  

•  Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create the report for specific 
vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicles ID in the list.  

•  Click once to select the vehicle and click a second time to de-select the vehicle.  

•  Multiple vehicles can be selected for the report. 

8. Check Mileage by type to include a breakdown of the trip mileage by type of trip. DriveRight supports the 
following trip types: business, personal, commute and other. 
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9. To specify a start date and end date for the report, check Trips Between and then enter the starting and ending 
dates. 

10. Select the type of output for the report: Excel, Report Viewer, or Email. 

11. Click on the Formula button to set or change the time definitions for night and weekend driving.  

12. Click OK to create the report or click Cancel to exit the dialog box. 

Trip Summary Report 

The Trip Summary Report provides a quick and easy-to-read summary of trips taken by either drivers or vehicles. 

To create a Trip Summary Report: 

1. Select Trip Summary Report from the Reports Menu. The Trip Summary Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sorting criteria from the drop-down list. 

4. Select All Drivers to print the report for all drivers, or select Driver Names to create the report for specific drivers. 

5. If you are creating a report for specific drivers, click on the drivers name in the list.  

•  Click once to select the drive and click a second time to de-select the driver.  

•  Multiple drivers can be selected for the report. 
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6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create the report for specific 
vehicles. 

7. If you are creating a report for specific vehicles, click on the vehicles ID in the list.  

•  Click once to select the vehicle and click a second time to de-select the vehicle.  

•  Multiple vehicles can be selected for the report. 

8. To specify a start date and end date for the report, check Trips Between and then enter the starting and ending 
dates. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Tamper Logs Report 

The Tamper Logs Report allows you to view the tamper logs for the selected drivers. The report is displayed by the 
DriveRight FMS Report Viewer. 

To view the Tamper Logs Report: 

1. Select Tamper Logs Report from the Reports Menu. The Tamper Logs Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Select the Sort by criteria by clicking next to either Driver Name or Date. 
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4. Check All Drivers to create an Tamper Logs Report for all drivers in the database.  

5. Check Driver Names to create an Tamper Logs Report for specific drivers in the database. 

6. If you are creating the report for specific drivers, select the driver name from the list.  

•  Click once to select a driver. Click a second time to de-select.  

•  Multiple drivers can be selected for the report. 

7. Select Trips Between to create a report that only lists trips taken between specific dates. If you select Trips 
Between, then indicate the Start Date and End Date for the reported trips. 

8. Enter the maximum allowable time between unplugging the DriveRight and downloading. Only tampers that 
exceed this time before download will be included in the report. 

9. Click OK to create the report or click Cancel to exit the dialog box. 

10. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 

Relationship Report 

The Relationship Report displays the vehicle and default driver assigned to each of the DriveRight devices in your 
database. 

To view the Relationship Report: 

1. Select Relationship Report from the Reports Menu. The report is displayed using the DriveRight FMS Report 
Viewer. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 
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Odometer Report 

The Odometer Report allows you to view the odometer reading for vehicles in the database, as well as the number of 
days since the last download for that vehicle and the date the last odometer adjustment was made. A report option 
allows you to included the default driver for each vehicle listed in the report. 

To view the Odometer Report: 

1. Select Odometer Report from the Reports Menu. The Odometer Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to change the location if 
necessary. 

3. Check All Vehicles to create an Odometer Report for all vehicles in the database.  

4. Check Veh ID/Lic. No to create an Odometer Report for specific vehicles in the database. 

5. If you are creating the report for specific vehicles, select the vehicle’s ID from the list.  

•  Click once to select the vehicle and click a second time to clear the vehicle.  

•  Multiple vehicles can be selected for the report. 

6. Select the Sort By criteria from the drop-down list: Vehicle ID, License and Odometer. 

7. Check Show Default Driver if you want the name of the default driver for each vehicle included in the report. 

8. Click OK to create the report or click Cancel to exit the dialog box. 

•  If you click OK, the report is displayed using the Report Viewer.  

•  You can print the report using the Print command in the File Menu. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking on the Clear Screen 

icon: . 
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Days Since Last Download Report 

The Days Since Last Download Report allows you to quickly see the number of days that have elapsed since a 
DriveRight or CarChip device has been downloaded into the DriveRight FMS database.  

•  The report is sorted by the number of days since the last download.  

•  Devices with the most number of days since the last download are listed first. 

To create the Days Since Last Download Report: 

1. Select Days Since Last Download from the Reports Menu. The Days Since Last Download Report dialog box is 
displayed. 

 

2. Select All Locations to create a report for all DriveRight and CarChip devices in all locations in your database. 

3. Select Location Names to create a report for specific locations, then select the locations from the list.  

•  Click once to select a location and click a second time to clear the location from the report.  

•  Multiple locations can be selected for this report. 

4. Click OK to create the report or click Cancel to exit. 

•  If you click OK, the report is displayed using the Report Viewer.  

5. To print the report, use the Print command in the File Menu. 

6. To clear the report from the screen, use the Clear Screen command in the File Menu or click on the Clear 

Screen icon: . 
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Help Menu 

The following commands are available in the Help Menu: 

•  Help Topics - Opens the Help Topics window showing the Contents, Index, and Search options. 

•  About DriveRight FMS 3.0 - Displays the program version information, the release date, and the copyright 
information. 
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Troubleshooting 

If you encounter problems installing or using DriveRight FMS, please contact Davis Instruments Technical Support: 

•  Device Communication Problems 

•  Database Connection Problems 

•  Miscellaneous Problems 

•  Contacting Davis Instruments 

Device Communication Problems 

Take the following steps if the software does not communicate with a DriveRight or CarChip device.  

1. DriveRight devices only - Check to make sure the DriveRight console is in the CURRENT mode instead of in 
sleep mode. If the LCD screen is blank, the console is in sleep mode. Press the MODE key to put the console in 
active mode..  

2. Check that the correct Serial Port is selected.  

3. If you have other programs running which use the serial port (such as the Palm HotSync Manager or the 
CarChip software), close those programs and try again. 

4. Check if the hardware is ok and that you have a working communication port. If necessary, contact your PC 
supplier. 

Database Connection Problems 

Since DriveRight FMS supports multiple database systems, things could go wrong during database connection due to 
various reasons. 

  

Database Setup Error 

Refer to the instructions in the message box if you get the following error message: 
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Database Not Setup Properly 

Refer to the instructions below if you get the following error message: 

 

•  If you are using MS Access: The database does not exist at the specified location. 

•  If you are using any other database: Either the database server is not running, or you do not have enough 
permissions to connect. Please refer to database configuration in the DriveRight FMS Database Selection 
Guide. 

Miscellaneous Problems 

If you selected the wrong database type during the initial program configuration, you can manually reset the database 
type in the config.txt file and then start over all again.  

1. If DriveRight FMS is open, close it. 

2. First locate the configuration file config.txt present in DriveRight FMS install directory. 

3. Open the file (it should come up in MS Notepad), and you’ll see the following text near the beginning of the file: 

  
############################################## 
# this variable represents the database type  
# used to store the data 
# 0- represents Database connection is not yet configured 
# 1- represents MS Access 
# 2- represents MySQL 
# 3- represents Oracle 
# 4- represents MSDE/MS SQL 
############################################## 

DATABASE_TYPE=2 

  

4. Edit the last line, and replace the number by 0 (zero, not capital O). After you edit the variable, the text in the file 
looks like this: 

DATABASE_TYPE=0 

  

5. Save the file and close MS Notepad. 

6. Run DriveRight FMS again and you will prompted to select the database type. If you need assistance, refer to 
the database installation instructions in the DriveRight FMS Database Selection Guide. 

Contacting Davis Instruments 

You may contact Davis Instruments for technical support or product information using any of the methods shown 
below. 
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Technical Support 

Our Technical Support Team is available Monday through Friday, 7:00 a.m. to 5:30 p.m. Pacific Time. Or use our 
website, fax, fax-back, or email any time day or night. 

•  Phone Technical Support: 510-732-7814  

•  Fax Technical Support: 510-670-0589  

•  Email Technical Support: support@davisnet.com 

•  Website Support Pages: http://www.davisnet.com/support/index.asp   

Note: Our website support section includes manuals for all products, technical notes, spec sheets, installation 
diagrams, and more. 

Other Ways to Contact Davis Instruments 

•  Sales (US & Canada): 800-678-3669  

•  Sales (Outside the US & Canada): 510-732-9229  

•  Fax: 510-670-0589  

•  Email to our Customer Service Department: sales@davisnet.com 

•  Email for comments or general information on Davis Instruments: info@davisnet.com 

•  Website: http://www.davisnet.com/ 
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Copyrights 

Copyright Notice 

The zipping and unzipping of files during backup/restore, FTP export/import are done using the following utility DLLs: 
ZIPDLL.DLL and UNZDLL.DLL. 

  

COPYRIGHT STATEMENT FOLLOWS THIS LINE 

DriveRight Fleet Management Software Copyright 

IMPORTANT! READ CAREFULLY: This software license agreement is a legal agreement between you (either an 
individual or an entity) and Davis Instruments Corporation (DAVIS). If you do not agree to the terms of this agreement, 
promptly return the software packet and the accompanying items to the place you obtained them for a full refund. 

GRANT OF LICENSE. The enclosed software is copyrighted material. This license agreement permits you to use one 
copy of the Davis Instruments software included in this package (the SOFTWARE) on a single computer. The 
SOFTWARE is in use on a computer when it is loaded into temporary memory (i.e., RAM) or installed into permanent 
memory (e.g., a hard disk) of that computer. Note the following conditions to this agreement. 

1. You may not install the software on a network, unless the software is used on only one computer or a separate license 
(EXTRA USER LICENSE) is obtained for each additional computer on which the software is used. However, you may 
install the software on a network for the sole purpose of distribution to additional computers, provided you have an 
EXTRA USER LICENSE for each additional computer. Contact DAVIS for clarification or information about EXTRA 
USER LICENSES. 

2. You may not make changes, decompile, or reverse engineer the software. 

3. You may not rent, lease, or loan the SOFTWARE, but you may transfer the SOFTWARE, accompanying DAVIS 
hardware, and user documentation on a permanent basis provided you retain no copies and the recipient agrees to the 
terms of this Agreement. If the SOFTWARE is an update or has been updated, any transfer must include the most recent 
update and all prior versions. 

DAVIS reserves the right to terminate this license if there is a violation or default of this agreement. At that time, all 
copies of the software and documentation must be returned to DAVIS and the customer will be liable to DAVIS for all 
damages suffered as a result of that violation or default. 

LIMITED WARRANTY 

DAVIS warrants to the original end user of the SOFTWARE that the SOFTWARE will operate in conformity with the 
documentation for such software. DAVIS warrants that (a) the SOFTWARE will perform substantially in accordance with 
the accompanying documentation for a period of one (1) year from the date of receipt and (b) any DAVIS hardware 
accompanying the SOFTWARE will be free from defects in material and workmanship under normal use and service for 
a period of one (1) year from the date of receipt. All implied warranties on the SOFTWARE and hardware are limited to 
one (1) year. This warranty will be void if the software has been modified, tampered with, or improperly used. This 
warranty will be effective only if the Registration Card included with the product is returned to DAVIS. 

To the maximum extent permitted by applicable law, DAVIS disclaims all other warranties, either express or implied, 
including, but not limited to implied warranties of merchantability and fitness for a particular purpose, with regard to the 
SOFTWARE, the documentation, and the accompanying hardware. 

To the maximum extent permitted by applicable law, in no event shall DAVIS be liable for any damages whatsoever 
(including without limitation, direct or indirect damages for personal injury, loss of business profits, business interruption, 
loss of business information, or other pecuniary loss) arising out of the use or inability to use this product, even if DAVIS 
has been advised of the possibility of such damages. In any case, DAVIS’ entire liability under any provision of this 
agreement shall be limited to the amount actually paid by you for the SOFTWARE and/or hardware. 

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of incidental or 
consequential damages, so the above limitations may not apply to you. This warranty gives you specific legal rights. You 
may have other rights, which vary from state to state. 

Davis Software License Agreement for Installation Dialog Box October 30, 2002 

Info-ZIP Copyright 

This is version 2002-Feb-16 of the Info-ZIP copyright and license. The definitive version of this document should be 
available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.  
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Copyright (c) 1990-2002 Info-ZIP. All rights reserved.  

For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals:  

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley, Ian Gorman, 
Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny 
Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg 
Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Christian Spieler, Antoine Verheijen, Paul von Behren, Rich 
Wales, Mike White  

This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its 
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of or 
inability to use this software.  

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it 
and redistribute it freely, subject to the following restrictions:  

Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of conditions.  

Redistributions in binary form (compiled executables) must reproduce the above copyright notice, definition, disclaimer, 
and this list of conditions in documentation and/or other materials provided with the distribution. The sole exception to 
this condition is redistribution of a standard UnZipSFX binary as part of a self-extracting archive; that is permitted without 
inclusion of this license, as long as the normal UnZipSFX banner has not been removed from the binary or disabled.  

Altered versions--including, but not limited to, ports to new operating systems, existing ports with new graphical 
interfaces, and dynamic, shared, or static library versions--must be plainly marked as such and must not be 
misrepresented as being the original source. Such altered versions also must not be misrepresented as being Info-ZIP 
releases--including, but not limited to, labeling of the altered versions with the names "Info-ZIP" (or any variation thereof, 
including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of 
Info-ZIP. Such altered versions are further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail 
addresses or of the Info-ZIP URL(s).  

Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ," "Pocket UnZip," "Pocket Zip," 
and "MacZip" for its own source and binary releases.  

  

END OF COPYRIGHT STATEMENTS 
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